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Chapter 1: Important information

Warning: Product installation
and operation

» This product must be installed and
operated in accordance with the
instructions provided. Failure to do so
could result in personal injury, damage
to your vessel and/or poor product
performance.

* Raymarine recommends certified
installation by a Raymarine approved
installer. A certified installation qualifies
for enhanced product warranty benefits.
Contact your Raymarine dealer for
further details, and refer to the separate
warranty document packed with your
product.

Caution: Power supply
protection

When installing this product ensure the
power source is adequately protected
by means of a suitably-rated fuse or
automatic circuit breaker.

Caution: Sun covers

* If your product is supplied with a sun
cover, to protect against the damaging
effects of ultraviolet (UV) light, always
fit the sun cover when the product is
not in use.

* Sun covers must be removed when
travelling at high speed, whether in
water or when the vessel is being
towed.

Warning: Potential ignition
source

This product is NOT approved for use in
hazardous/flammable atmospheres. Do
NOT install in a hazardous/flammable
atmosphere (such as in an engine room
or near fuel tanks).

Warning: Product grounding

Before applying power to this product,
ensure it has been correctly grounded, in
accordance with the instructions provided.

Caution: Product cleaning
When cleaning products:

* If your product includes a display
screen, do NOT wipe the screen with
a dry cloth, as this could scratch the
screen coating.

* Do NOT use abrasive, or acid or
ammonia based products.

* Do NOT use a jet wash.

Warning: Positive ground
systems

Do not connect this unit to a system which
has positive grounding.

Caution: Service and
maintenance

This product contains no user serviceable
components. Please refer all maintenance
and repair to authorized Raymarine
dealers. Unauthorized repair may affect

your warranty.

Warning: Switch off power
supply

Ensure the vessel’'s power supply is
switched OFF before starting to install this
product. Do NOT connect or disconnect

equipment with the power switched on,
unless instructed in this document.

Warning: Power supply
voltage

Connecting this product to a voltage
supply greater than the specified
maximum rating may cause permanent
damage to the unit. Refer to the Technical
specification section for voltage rating.

Important information

TFT Displays

The colors of the display may seem to vary when
viewed against a colored background or in colored
light. This is a perfectly normal effect that can

be seen with all color Thin Film Transistor (TFT)
displays.

Water ingress

Water ingress disclaimer

Although the waterproof rating capacity of this
product meets the stated IPX standard (refer to the
product’s Technical Specification), water intrusion
and subsequent equipment failure may occur if the
product is subjected to commercial high-pressure
washing. Raymarine will not warrant products
subjected to high-pressure washing.




Disclaimer

Raymarine does not warrant that this product is
error-free or that it is compatible with products
manufactured by any person or entity other than
Raymarine.

Raymarine is not responsible for damages or injuries
caused by your use or inability to use the product,
by the interaction of the product with products
manufactured by others, or by errors in information
utilized by the product supplied by third parties.

EMC installation guidelines

Raymarine equipment and accessories conform to
the appropriate Electromagnetic Compatibility (EMC)
regulations, to minimize electromagnetic interference
between equipment and minimize the effect such
interference could have on the performance of your
system

Correct installation is required to ensure that EMC
performance is not compromised.

Note: In areas of extreme EMC interference,
some slight interference may be noticed on the
product.Where this occurs the product and the
source of the interference should be separated by

a greater distance.

For optimum EMC performance we recommend
that wherever possible:

* Raymarine equipment and cables connected to
it are:

— Atleast 1m (3ft) from any equipment transmitting
or cables carrying radio signals e.g. VHF radios,
cables and antennas. In the case of SSB radios,
the distance should be increased to 7 ft (2 m).

— More than 2m (7ft) from the path of a radar
beam. A radar beam can normally be assumed
to spread 20 degrees above and below the
radiating element.

» The product is supplied from a separate battery
from that used for engine start. This is important to
prevent erratic behavior and data loss which can
occur if the engine start does not have a separate
battery.

» Raymarine specified cables are used.

» Cables are not cut or extended, unless doing so is
detailed in the installation manual.

Note: Where constraints on the installation
prevent any of the above recommendations,
always ensure the maximum possible separation
between different items of electrical equipment, to
provide the best conditions for EMC performance

throughout the installation

Suppression ferrites

* Raymarine cables may be pre-fitted or supplied
with suppression ferrites. These are important for
correct EMC performance. If ferrites are supplied
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separately to the cables (i.e. not pre-fitted), you
must fit the supplied ferrites, using the supplied
instructions.

+ If a ferrite has to be removed for any purpose (e.g.
installation or maintenance), it must be replaced in
the original position before the product is used.

» Use only ferrites of the correct type, supplied by
Raymarine or its authorized dealers.

» Where an installation requires multiple ferrites to
be added to a cable, additional cable clips should
be used to prevent stress on the connectors due
to the extra weight of the cable.

Connections to other equipment

Requirement for ferrites on non-Raymarine cables

If your Raymarine equipment is to be connected
to other equipment using a cable not supplied by
Raymarine, a suppression ferrite MUST always be
attached to the cable near the Raymarine unit.

Declaration of conformity

Raymarine UK Ltd. declares that this product is
compliant with the essential requirements of EMC
directive 2004/108/EC.

The original Declaration of Conformity certificate
may be viewed on the relevant product page at
www.raymarine.com.

Product disposal

Dispose of this product in accordance with the
WEEE Directive.

)i

mmm The Waste Electrical and Electronic Equipment
(WEEE) Directive requires the recycling of waste
electrical and electronic equipment.

Warranty registration

To register your Raymarine product ownership,
please visit www.raymarine.com and register online.

It is important that you register your product to
receive full warranty benefits. Your unit package
includes a bar code label indicating the serial number
of the unit. You will need this serial number when
registering your product online. You should retain
the label for future reference.

IMO and SOLAS

The equipment described within this document

is intended for use on leisure marine boats and
workboats NOT covered by International Maritime
Organization (IMO) and Safety of Life at Sea
(SOLAS) Carriage Regulations.


http://www.raymarine.com
http://www.raymarine.com

Technical accuracy

To the best of our knowledge, the information in this
document was correct at the time it was produced.
However, Raymarine cannot accept liability for any
inaccuracies or omissions it may contain. In addition,
our policy of continuous product improvement may
change specifications without notice. As a result,
Raymarine cannot accept liability for any differences
between the product and this document. Please
check the Raymarine website (www.raymarine.com)
to ensure you have the most up-to-date version(s) of
the documentation for your product.

Important information

1
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Chapter 2: Document and product information
Chapter contents

* 2.1 Document information on page 14
* 2.2 Product overview on page 14

Document and product information



2.1 Document information

This document contains important information
related to the installation of your Raymarine product.
The document includes information to help you:

» plan your installation and ensure you have all the
necessary equipment;

* install and connect your product as part of a wider
system of connected marine electronics;

» troubleshoot problems and obtain technical
support if required.

This and other Raymarine product documents
are available to download in PDF format from
www.raymarine.com.

Applicable products

This document is applicable to the following products:

Part number | Name Description

E22172 i70 multifunction
Instrument
display

Document illustrations

Your product may differ slightly from that shown
in the illustrations in this document, depending on
product variant and date of manufacture.

All images are provided for illustration purposes only.

Product documentation

The following documentation is applicable to your
product:

Description Part number
i70 Installation and operation instructions 81357
Installation and operation instructions for the
i70 unit and connection to a wider system of
marine electronics.
i70 Mounting template 87130
Mounting diagram for surface mounting a i70
unit.

Additional documentation
Description Part number
SeaTalkng® reference manual 81300

iTC-5 Installation instructions 87138

14

2.2 Product overview

The i70 is a multifunctional instrument display with
AIS capabilities. In conjunction with a compatible
instrument transducer and an iTC-5, the i70 provides
a detailed view of environmental, navigational and
vessel data.

D13574-1

The i70 has the following features:

* 4.1” high brightness color LCD with wide viewing
angles

+ SeaTalkng®, NMEA 2000 and SeaTalk compatible

 Large clear characters (up to 43 mm / 1.7 in) for
easy reading in any conditions

» Easy to use LightHouse™ operating system
» AIS repeater and display of AlS targets

» Data views include: Wind, Speed, Depth, Tridata,
Engine, Environment, Fuel and Navigation

* 12V dc operation
* Low power consumption

» Waterproof to IPx6


http://www.raymarine.com

Chapter 3: Planning the installation

Chapter contents

3.1 Installation checklist on page 16

3.2 Parts supplied on page 16

3.3 Software updates on page 17

3.4 Tools on page 17

3.5 Typical systems on page 18

3.6 System protocols on page 21

3.7 Warnings and cautions on page 21

3.8 General location requirements on page 22
3.9 Product dimensions on page 23

Planning the installation



3.1 Installation checklist

Installation includes the following activities:

Installation Task

3.2 Parts supplied

The following parts are supplied with your product.

Plan your system.

Obtain all required equipment and tools.

Site all equipment.

Route all cables.

Drill cable and mounting holes.

Make all connections into equipment.

Secure all equipment in place.

Ol N|OO|JlO|B~|lOIN]|—~

Power on and test the system.

Schematic diagram

A schematic diagram is an essential part of planning
any installation. It is also useful for any future
additions or maintenance of the system. The
diagram should include:

* Location of all components.
» Connectors, cable types, routes and lengths.

16
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D12054-2

Description

i70 Multifunction instrument display

Bezel

400 mm (15.8 in.) SeaTalkng® Spur Cable

Panel seal gasket

Suncover

Documentation pack

SeaTalkng® Blanking plug

ol N|oOojla|lb|lWWIN]—~

4 x M3x16 pan head PZ screws

Unpack the unit carefully to prevent damage. Save
the carton and packing in case the unit has to be

returned for service.

Compatible transducers

For a list of compatible transducers please refer to

Chapter 18 Options and accessories.




3.3 Software updates

3.4 Tools

The software running on the product can be updated. Tools required for installation

Raymarine periodically releases software updates
to improve product performance and add new
features.

You can update the software for your product using
a connected and compatible multifunction display.

Refer to www.raymarine.com/software/ for the
latest software updates and the software update
procedure for your product.

If in doubt as to the correct procedure for updating
your product software, refer to your dealer or
Raymarine technical support.

Caution: Installing software
updates

The software update process is carried
out at your own risk. Before initiating the
update process ensure you have backed
up any important files.

D12055-1

Ensure that the unit has a reliable power 1. Power dfrill
_supply and that the update process is not o Jig saw
interrupted. -
Damage caused by incomplete updates 3 Screwdriver
are not covered by Raymarine warranty. 4. Suitable size (10 mm to 30
By downloading the software update mm) hole cutter
package, you agree to these terms. 5. File
6. Adhesive tape
7. Drill bit of appropriate size ()

Planning the installation

Note: (1) Drill bit size is dependent on the
thickness and type of material that the unit is to
be mounted on.
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3.5 Typical systems

The following illustrations show the products that can
be connected in a typical system.

Example: Simple environmental data system

D13575-1

Item Description

1 Instrument display (e.g. i70)

2 SeaTalkng® 12 V dc power supply

3 iTC-5 converter

4 Depth transducer (Analog)

5 Speed / Temperature transducer
(Analog)

6 Wind transducer (Analog)

18



Example: Expanded system without autopilot

SeaTalk"9

D13421-1

Item Description

1 AIS receiver / transceiver (AlIS350 / AIS650)
2 Instrument display (e.g. i70)

3 Life Tag — Man Over Board (MOB) system
4 SeaTalkng® GPS/GNSS Receiver (e.g. RS130)
5 SeaTalkng® 12 V dc power supply

6 Fluxgate compass

7 SeaTalk to SeaTalkng® converter

8 Vessel / Engine systems

9 iTC-5 converter

10 Rudder reference

" Depth transducer (Analog)

12 Wind transducer (Analog)

13 Speed / Temperature transducer (Analog)
14 ECI-100

Note: Depending on engine type, it may be possible to connect the engine
system directly to the SeaTalkng® backbone using a SeaTalkng® to DeviceNet
adaptor cable. Without using the ECI-100 the available data will be limited to

supported, standard NMEA 2000 data only.

Planning the installation




Example: Expanded system with autopilot
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SeaTalk"d
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SeaTalk"d
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12V dc/
24V dc

Item Description

1 AIS receiver / transceiver (AIS350 / AIS650)

2 Instrument display (e.g. i70)

3 Life Tag — Man Over Board (MOB) system

4 Pilot Controller (e.g. p70 or p70R)

5 Evolution™ Autopilot

6 SeaTalkng® GPS/GNSS Receiver (e.g. RS130)

7 SeaTalk to SeaTalkng® converter

8 iTC-5 converter

9 ACU (Autopilot Control Unit)

10 ECI-100
Note: Depending on engine type, it may be possible to connect the engine
system directly to the SeaTalkng® backbone using a SeaTalkng® to DeviceNet
adaptor cable. Without using the ECI-100 the available data will be limited to
supported, standard NMEA 2000 data only.

" Vessel / Engine systems

12 Depth transducer (Analog)

13 Wind transducer (Analog)

14 Speed / Temperature transducer (Analog)

15 Rudder reference

16 12V dc /24 V dc power supply (powering the SeaTalkng® backbone.)

20




3.6 System protocols

Your product can be connected to various products
and systems to share information and so improve
the functionality of the overall system.

These connections may be made using a number of
different protocols. Fast and accurate data collection
and transfer is achieved by using a combination of
the following data protocols:

« SeaTalkng®
« NMEA 2000
» SeaTalk

3.7 Warnings and cautions

Important: Before proceeding, ensure that you
have read and understood the warnings and
cautions provided in the Chapter 1 Important
information section of this document.

Note: You may find that your system does not
use all of the connection types or instrumentation

described in this section.

SeaTalkng®

SeaTalkng® (Next Generation) is an enhanced
protocol for connection of compatible marine
instruments and equipment. It replaces the older
SeaTalk and SeaTalk2 protocols.

SeaTalkng® utilizes a single backbone to which
compatible equipment connect using a spur. Data
and power are carried within the backbone. Devices
that have a low draw can be powered from the
network, although high current equipment will need
to have a separate power connection.

SeaTalkng® is a proprietary extension to NMEA 2000
and the proven CAN bus technology. Compatible
NMEA 2000 and SeaTalk and SeaTalk2 devices can
also be connected using the appropriate interfaces
or adaptor cables as required.

NMEA 2000

NMEA 2000 offers significant improvements over
NMEA 0183, most notably in speed and connectivity.
Up to 50 units can simultaneously transmit and
receive on a single physical bus at any one time,
with each node being physically addressable. The
standard was specifically intended to allow for

a whole network of marine electronics from any
manufacturer to communicate on a common bus via
standardized message types and formats.

SeaTalk

SeaTalk is a protocol which enables compatible
instruments to connect to each other and share data.

The SeaTalk cable system is used to connect
compatible instruments and equipment. The cable
carries power and data and enables connection
without the need for a central processor.

Additional instruments and functions can be added to
a SeaTalk system, simply by plugging them into the
network. SeaTalk equipment can also communicate
with other non-SeaTalk equipment via the NMEA

0183 standard, provided a suitable interface is used.

Planning the installation
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3.8 General location requirements Viewing angle considerations

As display contrast, color and night mode
performance are all affected by the viewing angle,
Raymarine recommends you temporarily power up
This product is suitable for mounting above or below the display when planning the installation, to enable
decks. you to best judge which location gives the optimum
viewing angle.

Important considerations when choosing a suitable
location for your product.

The product should be mounted where it will be:

» protected from physical damage and excessive
vibration.

» well ventilated and away from heat sources.

» away from any potential ignition source such as an
engine room, near fuel tanks or a gas locker.

When choosing a location for the product,
consider the following points to ensure reliable and
trouble-free operation:

* Access — there must be sufficient space to
enable cable connections to the product, avoiding
tight bends in the cable.

* Diagnostics — the product must be mounted in
a location where the diagnostics LED is easily
visible.

Note: Not all products include a diagnostics
LED. Refer to the Chapter 15 System checks
and troubleshooting for more information.

* Electrical interference — the product should be
mounted far enough away from any equipment
that may cause interference such as motors,
generators and radio transmitters / receivers.

* Magnetic compass — refer to the Compass
safe distance section in this document for advice
on maintaining a suitable distance between this
product and any compasses on your vessel.

* Power — to keep cable runs to a minimum, the
product must be located as close as possible to
the vessel's dc power supply.

* Mounting surface — ensure the product is
adequately supported on a secure surface. Refer
to the weight information provided in the Technical
specification for this product and ensure that the
intended mounting surface is suitable for bearing
the product weight. Do NOT mount units or cut
holes in places which may damage the structure
of the vessel.

Compass safe distance

To prevent potential interference with the vessel's
magnetic compasses, ensure an adequate distance
is maintained from the product.

When choosing a suitable location for the product
you should aim to maintain the maximum possible
distance from any compasses. Typically this distance
should be at least 1 m (3 ft) in all directions. However
for some smaller vessels it may not be possible to
locate the product this far away from a compass. In
this situation, when choosing the installation location
for your product, ensure that the compass is not
affected by the product when it is in a powered state.

22



3.9 Product dimensions
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Item Description

A. 110 mm (4.33")

B. 115 mm (4.52")

C. 14 mm (0.55”)

D. 30 mm (1.18”)

E. 35 mm (1.38”)

F. 90 mm (3.54")

G. 17 mm (0.67")

Planning the installation
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Chapter 4: Cables and connections

Chapter contents

4.1 General cabling guidance on page 26

4.2 Connections overview on page 26

4.3 SeaTalkng® power supply on page 27

4.4 Cable ferrite installation on page 29

4.5 SeaTalkng connection on page 30

4.6 NMEA 2000 network connection on page 31
4.7 SeaTalk connection on page 31

4.8 Transducer connections on page 32

Cables and connections
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4.1 General cabling guidance

Cable types and length

It is important to use cables of the appropriate type
and length

* Unless otherwise stated use only standard cables
of the correct type, supplied by Raymarine.

+ Ensure that any non-Raymarine cables are of the
correct quality and gauge. For example, longer
power cable runs may require larger wire gauges
to minimize voltage drop along the run.

Routing cables

Cables must be routed correctly, to maximize
performance and prolong cable life.

* Do NOT bend cables excessively. Wherever
possible, ensure a minimum bend diameter of 200
mm (8 in) / minimum bend radius of 100mm (4 in).

4.2 Connections overview

Use the following information to help you identify the
connections on your product.

Connector | Qty | Connects to: Suitable cables
2 1. SeaTalkng® | 1. SeaTalkng®
backbone spur cables

2. NMEA 2000 [2. SeaTalkng®

backbone to DeviceNet

3. SeaTak adaptor

backbone (A06045)

% Sealakng® |3 seatalk to
SeaTalkng®
adaptor
cable
(A06073)

200mm@in)

‘\’ ] /
\ /e————————100 mm (4 in)

(o] (el

* Protect all cables from physical damage and
exposure to heat. Use trunking or conduit where
possible. Do NOT run cables through bilges or
doorways, or close to moving or hot objects.

» Secure cables in place using tie-wraps or lacing

twine. Coil any extra cable and tie it out of the way.

* Where a cable passes through an exposed
bulkhead or deckhead, use a suitable watertight
feed-through.

* Do NOT run cables near to engines or fluorescent
lights.

Always route data cables as far away as possible
from:

» other equipment and cables,
+ high current carrying AC and DC power lines,

¢ antennae.

Strain relief

Ensure adequate strain relief is provided. Protect
connectors from strain and ensure they will not pull
out under extreme sea conditions.

Cable shielding

Ensure that all data cables are properly shielded
that the cable shielding is intact (e.g. hasn’t been
scraped off by being squeezed through a tight area).
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Connecting SeaTalkng® cables

0

D12615-2

1. Rotate the locking collar on the unit to the
unlocked position.

Ensure the cable’s connector is correctly oriented.
Fully insert the cable connector.

4. Rotate locking collar clockwise (2 clicks) until it is
in the locked position.

w N

SeaTalkng® product loading

The number of products that can be connected to

a SeaTalkng® backbone depends on the power
consumption of each product and the physical overall
length of the backbone.

SeaTalkng® products have a Load Equivalency
Number (LEN), which indicates the product’'s power
consumption. The LEN for each product can be
found in the product’s Technical Specification.



4.3 SeaTalkng® power supply

Power is supplied to the product over the SeaTalkng®
backbone.

A SeaTalkng® backbone requires one 12 V dc power
supply, connected to the SeaTalkng® backbone.
This can be provided by:

» a battery (1), via the distribution panel,
+ an Autopilot Control Unit (ACU)),
» an SPX course computer (2),

» for 24 V vessels a 5 amp, regulated, continuous
24 V dc to 12 V dc converter is required.

Note:

* (1) The battery used for starting the vessel’s
engine(s) should NOT be used to power the
SeaTalkng® backbone as this can cause sudden
voltage drops, when the engines are started.

* (2) The ACU-100 and SPX-5 cannot be used to
power the SeaTalkng® backbone.

In-line fuse and thermal breaker
ratings

The SeaTalkng® network’s power supply requires an
in-line fuse or thermal breaker to be fitted.

In-line fuse rating
5A

Thermal breaker rating

3 A (if only connecting one
device)

Note: The suitable fuse rating for the thermal
breaker is dependent on the number of devices you
are connecting. If in doubt consult an authorized
Raymarine dealer.

SeaTalkng® system loading

The maximum loading / LEN for a SeaTalkng®
system depends on the length of the backbone.

SeaTalkng® power connection point

Small systems

If the backbone length is 60 m (197 ft) or less, the
power connection point may be connected at any
point in the backbone.

Large systems

If the backbone length is greater than 60 m (197 ft),
the power connection point should be connected at
a point that creates a balanced current draw from
each side of the backbone. The Load Equivalency
Number (LEN) is used to determine the power
connection point for the system.

D13424-1

In the example above the system has an overall LEN
of 10, so the optimum connection point would be to
have 5 LEN either side of the connection point.

Cables and connections

Loading type Backbone length | Total LEN
Unbalanced 20 m (66 ft) 40
Unbalanced 40 m (131 ft) 20
Unbalanced 60 m (197 ft) 14
Balanced 60 m (197 ft) or 100
less
Balanced 80 m (262 ft) 84
Balanced 100 m (328 ft) 60
Balanced 120 m (394 ft) 50
Balanced 140 m to 160 m 40
(459 ft to 525 ft)
Balanced 180 m to 200 m 32
(591 ft to 656 ft)

Power distribution — SeaTalkng®
Recommendations and best practice.

* Only use approved SeaTalkng® power cables. Do
NOT use a power cable designed for, or supplied
with, a different product.

» See below for more information on implementation
for some common power distribution scenarios.

Important: When planning and wiring, take into
consideration other products in your system, some
of which (e.g. sonar modules) may place large
power demand peaks on the vessel's electrical
system.

Note: The information provided below is for
guidance only, to help protect your product. It
covers common vessel power arrangements, but
does NOT cover every scenario. If you are unsure
how to provide the correct level of protection,
please consult an authorized Raymarine dealer or

a suitably qualified professional marine electrician.

Implementation — direct connection to battery

» SeaTalkng® power cables may be connected
directly to the vessel's battery, via a suitably rated
fuse or breaker.
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* You MUST fit a suitably rated fuse or breaker
between the red wire and the battery’s positive
terminal.

» Refer to the inline fuse ratings provided in the
product’s documentation.

 If you need to extend the length of the power
cable, ensure you use suitably rated cable and
that sufficient power (12 V dc) is available at the
SeaTalkng® backbone’s power connection.

If you need to extend the length of the power
cable, ensure you use suitably rated cable and
that sufficient power (12 V dc) is available at the
SeaTalkng® backbone’s power connection.

Important: Be aware that the suitable fuse rating
for the thermal breaker or fuse is dependent on the
number of devices you are connecting.

®

1

<=

D13344-1

A | Battery connection scenario A: suitable for a vessel with
a common RF ground point. In this scenario, if your
product’s power cable is supplied with a separate drain
wire then it should be connected to the vessel's common
ground point.

B | Battery connection scenario B: suitable for a vessel
without a common grounding point. In this case, if your
product’s power cable is supplied with a separate drain
wire then it should be connected directly to the battery’s
negative terminal.

Implementation — connection to distribution
panel

aoag | ooag
S0 SO0 :ﬁl:
00 000 0o i—;

I SOV VL —4

D13348-1

More information

Raymarine recommends that best practice is
observed in all vessel electrical installations, as
detailed in the following standards:

BMEA Code of Practice for Electrical and
Electronic Installations in Boats

NMEA 0400 Installation Standard

ABYC E-11 AC & DC Electrical Systems on Boats
ABYC A-31 Battery chargers and Inverters

ABYC TE-4 Lightning Protection

Sharing a breaker

Where more than 1 piece of equipment shares a
breaker you must provide protection for the individual
circuits. E.g. by connecting an in-line fuse for each
power circuit.

» Alternatively, the SeaTalkng® power cable may be
connected to a suitable breaker or switch on the
vessel's distribution panel or factory-fitted power
distribution point.

* The distribution point should be fed from
the vessel’s primary power source by 8AWG
(8.36mm?2) cable.

« lIdeally, all equipment should be wired to individual
suitably-rated thermal breakers or fuses, with
appropriate circuit protection. Where this is not
possible and more than 1 item of equipment
shares a breaker, use individual in-line fuses
for each power circuit to provide the necessary
protection.

¢ In all cases, observe the recommended
breaker / fuse ratings provided in the product’s
documentation.
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1 Positive (+) bar

2 Negative (-) bar

3 Circuit breaker

4 Fuse

Where possible, connect individual items of
equipment to individual circuit breakers. Where this
is not possible, use individual in-line fuses to provide
the necessary protection.

c Warning: Product grounding

Before applying power to this product,
ensure it has been correctly grounded, in
accordance with the instructions provided.




c Warning: Positive ground
systems

Do not connect this unit to a system which
has positive grounding.

Cables and connections

4.4 Cable ferrite installation

Your product is supplied with a cable ferrite. To
ensure EMC Compliance, the supplied ferrite must

be fitted to the cable according to the following
instructions.

SeaTgIk”Q = -
Device

SeaTalkn9

450 mm (1.97 in) - 100 mm (3.94 in)'

D13539-1

. The ferrite must be fitted to the end of the cable
closest to the device.

. The ferrite must be fitted at the distance specified
in the illustration above.

. Ensure a tight and secure fit so that the ferrite will

not move up or down the cable.
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4.5 SeaTalkn9 connection

Note: In the example below, if an ACU-100

network.

was used, the SeaTalkng network would require
a dedicated 12 V dc power supply because the
ACU-100 does not supply power to the SeaTalkng

Example: SeaTalkng SPX system with transducer

pods

Example: SeaTalkng Evolution system with iTC-5

*“‘ { Reyrmerine

o

D13026-1

SeaTalk"d

D12099-2

Item

Description

SPX (supplying 12V to SeaTalkd network.)

2 X Instruments

ACU unit

p70 / p70R Pilot controller

2 X Instruments

Vessel's 12 V dc power supply

Pilot controller

SeaTalknd 5-way connectors with terminators

Vessel's 12 V dc power supply

Transducer pods

EV unit

Rudder reference transducer

SeaTalkng 5-way connector

Fluxgate compass

Rudder reference transducer

olo|vw|lola|sr|lw|nv] =~

Wind transducer

iTC-5 converter

N
o

Speed transducer

Ol Nl WOIN]|—~

Depth transducer

—_
—_

Depth transducer

—_
o

Wind transducer

—_
N

Speed transducer
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4.6 NMEA 2000 network
connection

Your SeaTalkng® device can be connected to a
DeviceNet / NMEA 2000 network.

o—@

SeaTalk"9
device

D12060-3

SeaTalkng® device

2. SeaTalkng® to DeviceNet adaptor cable
(A06045)

3. DeviceNet T-piece
4. NMEA 2000 backbone

Cables and connections

4.7 SeaTalk connection

Connections to a SeaTalk network are made using a
SeaTalk to SeaTalkns adaptor cable (not supplied).

®
®@ O !
N E @

e it %
@%%
©—

12V
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Item Description

1. p70 Pilot controller

2. ST60+ Depth instrument

3. ST60+ Speed instrument

4. ST60+ Wind instrument

S. Wind transducer

6. SeaTalkns to SeaTalk Adaptor
cable

7. Depth transducer

8. Speed transducer

9. Course computer (supplying

12V to SeaTalk network.)

For SeaTalk cables and extensions, use Raymarine
SeaTalk cable accessories.

SeaTalk power protection

The power supply must be protected by a 5 A fuse
or a circuit breaker providing equivalent protection.

Raymarine recommends that the power is connected
to a SeaTalk system in such a way that the current
drawn on each side of the power connection point
is equal.
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4.8 Transducer connections

iTC-5 connection

For details on connecting an iTC-5 to the SeaTalkng®
backbone and connecting transducers to the iTC-5,
refer to the documentation provided with your iTC-5.

Transducer pod connection

Transducer pods are available for wind, depth
and speed transducers. For detailed installation
instructions, refer to documentation supplied with
your pod.

D12061-2

Item Description

1 Speed and Temperature
transdiucar

2 Speed pod

3 SeaTalkne® T-Piece
connector

1. Connect the transducer to the pod, the pod
terminals are color-coded, ensure that each wire
is connected to the corresponding terminal.

2. Connect the pod to the SeaTalkn9® backbone
using a SeaTalkn9®spur cable and T-piece. Pods
must be located no further than 400 mm (15.75
in.) from the connection point on the backbone
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Chapter 5: Mounting

Chapter contents
* 5.1 Mounting on page 34

Mounting
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5.1 Mounting

The product is designed to be flush mounted.
Before mounting the unit, ensure that you have:
» Selected a suitable location.

« |dentified the cable connections and route that the
cable will take.

* Detached the front bezel.

Front bezel

Removing the front bezel

D12064-1

1. Check the selected location for the unit. A clear,
flat area with suitable clearance behind the panel,
is required.

2. Fix the appropriate cutting template supplied
with the product, to the selected location, using
masking or self-adhesive tape.

3. Using a suitable hole saw, make a pilot holes in
each corner of the cut-out area.

4. Using a suitable saw, cut along the inside edge
of the cut-out line.

5. Ensure that the unit fits into the removed area
and then file around the cut edge until smooth.

6. Dirill four holes as indicated on the template to
accept the securing screws.

7. Peel the backing off of the gasket, and place the
adhesive side of the gasket onto the display unit
and press firmly onto the flange.

8. Connect cables to the unit.

9. Slide the unit into place and secure using screws
provided.

D12030-1

Important: Use care when removing the bezel.
Do not use any tools to lever the bezel, doing so

may cause damage.

Note: Drill, and tap size and tightening torque is
dependent on the material type and thickness the
unit is to be mounted on.
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1. Using your fingers pull the bezel away from the
unit at the top and side, as shown in 2.

The bezel will start to come away from the unit at
the top and side.

2. Now pull the bezel away from the unit on the
opposite side, as shown in 3.

The bezel will now come free from the unit, as
shown in 4.



Chapter 6: Getting started

Chapter contents

6.1 Instrument controls on page 36

6.2 Power on page 36

6.3 Completing the startup wizard on page 37

6.4 Display settings on page 37

6.5 Multiple data sources (MDS) overview on page 39
6.6 Quick Options menu on page 40

Getting started
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6.1 Instrument controls

Control layout and functions.

T

D12065-1

6.2 Power

Powering on the unit

The unit will automatically turn on with the system,
unless it has previously been powered off using the
Power button.

With the unit powered off:

1. Press and hold the Power button until the screen

turns on (approximately 2 seconds).
Powering off the unit

1. Press and hold the Power button until the count
down timer reaches zero and the screen turns off.

Note: When powered off, the unit may still draw
a small amount of power from the battery, if this
is a concern unplug the power supply or switch

off at the breaker.

Item Description

1. LEFT SOFT BUTTON Power,
brightness, cancel, back

2. UP ARROW Up navigation,
Adjust Up

3. DOWN ARROW Down
navigation, Adjust Down

4. RIGHT SOFT BUTTON

Menu, select, OK, Save
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6.3 Completing the startup wizard
When you power-up the unit for the first time or after
a system reset the Startup Wizard is displayed.

The setup wizard guides your through the following
basic configuration settings:

1. Language
2. Boat Type
3. Welcome

Language |

English (UK) >
[ ] English (US) >

Boat Type
s= Inboard Speedboat

<=3 Power Cruiser 1 (<12kts)

<= Power Cruiser 2 (<30kts)

[ ] Francais >

Select |

Welcome

Your i70s is now ready to
use. (For more settings,
including customising your
favorite pages & calibrating
transducers, open MENU)

Back Continue |

D13427-1

1. Using the Up and Down buttons, highlight the
user interface Language that you want to use
and then press the Menu button to confirm the
selection.

2. Using the Up and Down buttons, highlight the
Boat Type that you want to use and then press
the Menu button to confirm the selection.

The Welcome page is displayed.
3. Select Continue.

The first of a pre-defined set of Favorite pages is
displayed.

6.4 Display settings
Adjusting the unit’s brightness

To adjust the unit’'s LCD brightness level, when it
is not part of a Shared Brightness group follow the
steps below.

1. Press the Power button.
The Display Brightness page is displayed.

2. Use the Up and Down buttons to adjust the
brightness to the required level.

3. Select Ok.

The Display Brightness page will time-out after 2
seconds, saving the new brightness level.

Shared Brightness

You can set up Shared Brightness groups which
enables simultaneous brightness adjustment the all
units that are part of the same group.

The following products are compatible with Shared
Brightness:

* LightHouse™ powered MFDs

» SeaTalkng® Instrument displays and Pilot
controllers

- Ray50 / Ray52 / Ray60 / Ray70 VHF DSC Radios

Any adjustments to the Shared Brightness level will
be reflected on all units assigned to the same group.

Instrument display / Pilot

Note: The Startup Wizard may not be displayed
if these settings have already been set on the
system that the unit is connected to.

Getting started

LightHouse™ MFD Controller
< Shortcuts
Shared Brightness
.
| Unshare 0K
Ray50 / Ray52 / Ray60 /
Ray70 VHF DSC Radio

¢ - Backlight -

Multiple brightness groups can be configured. These
groups could be used to reflect the physical location
of units on your vessel. For example, the units at
your helm can be set to one group, and the units on
the flybridge can be set to a different group.

Shared Brightness requires:

+ all units to be compatible with the Shared
Brightness function (see list of compatible units
above).

+ the Share brightness setting set to On for all units
in the brightness group.

* units to be assigned to Network Groups.
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« all the displays in that group to be synchronized.

Assigning A Network Group

To enable the Shared Brightness and Color, unit’s
must be assigned to the same network group.

Compatible Instrument Displays and Pilot Controllers
will also share their Color Scheme.

From the Network Group menu: (Menu > Set-up >
System Set-up > Network Group)

1. Select the Network Group that you want to assign
the unit to.

A list of network groups will be displayed:
* None (default)
* Helm 1
* Helm 2
* Cockpit
* Flybridge
* Mast
* Group 1 — Group 5
2. Select Brightness/Color Group.

Select This Group.
4. Select Sync.

w

The System will now synchronize all units
assigned to the same group.

5. Select OK.
6. Carry out steps 1 to 5 on all unit’s.

The location of the Shared Brightness menu
on LightHouse™ MFDs is: (Homescreen >
Customize > Display Preferences > Shared
Brightness)

Adjusting the Brightness level will now effect all units
assigned to the same group.
Unsharing a unit

Instrument Displays and Pilot Controllers can be
removed from the Shared Brightness.

Unshare
Shared Brightness

Display Brightness

Share

<«

D13428-1

1. Press the Power button to display the Shared
Brightness page.

2. Select Unshare.

Selecting Share from the Display Brightness
page will switch back to Shared Brightness.

Changing the color scheme

From the colors menu: (Menu > Display Settings >
Colors)
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1. Select a color scheme from the list

* Day 1
* Day 2
* Inverse
* Red/Black
If the unit is part of a network group, the color

scheme selected will change on all units that support
color schemes and are part of the same group.

Display response

Setting the Display Response

Setting the Display Response to a low value will
dampen data fluctuations to provide a more stable
reading. Setting the Display Response to a high
value will reduce then damping to make readings
more responsive.

From the Display Settings menu: (Menu > Display
Settings )

1. Select Display Response.

2. Select the data type:

» Speed

* Depth

* Wind speed
* Wind angle
* Heading

3. Adjust the value as required.
4. Select Save.



6.5 Multiple data sources (MDS)
overview

When a system includes multiple instances of a
data source the preferred data source is selected
automatically. The systems preferred source may not
be your preferred source, or if you are experiencing a
data conflict you can manually select your preferred
data source.

MDS enables you to choose a preferred source for
the following data types:

» GPS Position
* GPS Datum
» Time & Date
* Heading

* Depth

* Speed

« Wind

This exercise would usually be completed as part
of the initial installation, or when new equipment is
added.

For MDS to be available all products in the system
that use the data sources listed above, must be
MDS-compliant. The system will report any products
that are NOT MDS-compliant. It may be possible

to upgrade the software for these products, to
make them compliant. Visit the Raymarine website
(www.raymarine.com) to obtain the latest software
for your products.

If MDS-compliant software is not available for the
product and you do NOT want to use the systems
preferred data source, you must remove any
non-compliant product from the system. You should
then be able to select your preferred data source.

Note: Once you have completed setting up your
preferred data sources, you may be able to add
the non-compliant products back into the system.

Selecting a preferred data source

From the System Set-up menu: (Menu > Set-up >
System Set-up)
1. Select Data Sources.

2. Select the Data type.

The unit will now search for and display a list of
all sources for the selected data type.

Getting started

Depth

/| Auto

00380016 STng - ACTIVE
ST70 Depth Pod

00420065 STng

iTC-5 Converter

Back Select

3. Select your preferred data source, or
4. Select Auto to allow the system to decide.

ACTIVE is displayed next to the data source that
is the current source for the data type.
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6.6 Quick Options menu

The Quick Options menu (Menu > Quick Options)
is a dynamic menu that displays menu items relative
to the data displayed on the current Favorite page or
Quick View page being viewed.

Quick options menu items

Depending on the page being displayed different
quick options are available as follows:

Page displayed Quick options available
Menu Edit page
MOB (when MOB is active) | MOB

Maximum depth

Reset Maximum Depth

Minimum depth

Reset Minimum Depth

Maximum speed

Reset Maximum Speed

Average speed Reset Average Speed
Trip Reset Trip
Max. SOG Reset Max. SOG
Ave. SOG Reset Ave. SOG
CMG & DMG Reset CMG & DMG
Maximum Sea Temperature | Reset Max. Sea
Temperature
Minimum Sea Temperature | Reset Min. Sea
Temperature

Maximum Air Temperature

Reset Max. Air Temperature

Minimum Air Temperature

Reset Min. Air Temperature

Maximum AWA Reset Maximum. AWA
Minimum AWA Reset Minimum. AWA
Maximum AWS Reset Max. AWS
Minimum AWS Reset Min. AWS
Maximum TWA Reset Max. TWA
Minimum TWA Reset Min. TWA
Maximum TWS Reset Max. TWS
Minimum TWS Reset Min. TWS
Race Timer Start timer

Stop timer

Reset timer

Adjust start times
Graph Time scale
(View data) page Add to favorites
AIS View AIS targets — (Only

shown if there is Heading or
stable COG data available.)

AIS range

AIS Silent mode
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Chapter 7: Transducer calibration

Chapter contents

7.1 Transducer types on page 42

7.2 Depth calibration on page 42

7.3 Speed calibration on page 43

7.4 Wind calibration on page 48

7.5 Rudder reference calibration on page 50
7.6 Compass calibration on page 51

Transducer calibration
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7.1 Transducer types

The transducers listed in the table below can be
calibrated using the display.

Transducer type Connection

Depth transducers connected via iTC-5 or Depth

pod

Speed and temperature connected via iTC-5 or Speed
transducers pod

connected via iTC-5 or Wind
pod

Wind transducers

Smart transducers connected directly to SeaTalkng®

Fluxgate compass connected via iTC-5

Rudder reference connected via iTC-5

42

7.2 Depth calibration
Depth Offset

Depths are measured from the transducer to the
bottom, you can apply an offset value to the depth
data, so that the displayed depth reading represents
the depth to the bottom from either the keel (negative
offset) or the waterline (positive offset).

Before attempting to set a waterline or keel
offset, find out the vertical separation between the
transducer and either the waterline or the bottom
of your vessel’'s keel, as appropriate. Then set the
appropriate depth offset value.

L2

AN —\

® @ ©®

D9343-2

1 Waterline offset | Values greater than zero (Positive

values) represent a waterline offset

2 Transducer Zero offset represents the depth
from the transducer’s location
3 Keel offset Values less than zero (Negative

values) represent a keel offset

Setting the depth offset

The depth calibration consists of setting a Depth
Offset that is relevant to your depth transducer’s
installed location.

From any favorite page:

1. Select Menu.

2. Select Set-up.

3. Select Transducers Set-up.

4. Select Continue.

The instrument display will search for and display
a list of connected devices. (i.e. iTC-5, DST or
transducer pod)

5. Select the device that the transducer(s) you are
calibrating are connected to.

A list of available transducer data is displayed,
6. * Select Depth.

Important: * Step only applicable to iTC-5.

7. Select Depth Offset.
8. Select Depth From:.
A list of transducer offsets is displayed:

* Waterline
* Keel
« Transducer (default)



9. Select the location that you want depth
measurements to be taken from.

After selection the Depth Offset page is displayed.

If you have selected Waterline or Keel a Depth
Offset must be applied.

10. Select Offset:.

11. Use the Up and Down buttons to adjust the
Depth Offset to the required value.

The offset value should be the same as the
measured distance:

« from the transducer face to the Waterline, or

» from the transducer face to the bottom of the
Keel.

12.Select Save.

Setting an incorrect Depth Offset could lead to your
vessel running aground.

Transducer calibration

7.3 Speed calibration

Speed transducer calibration is required as
transducer performance is affected by a number of
variables such as transducer location, shape of the
hull and water flow characteristics. The purpose
of performing Speed calibration is to ensure that
the speed readings at the instrument are a true
indication of the vessel’s actual speed.

In order to achieve accurate results, speed
calibration must be carried out in calm conditions
with zero tide and zero current.

Speed calibration aligns the instruments log speed
(Speed Through Water) to:

» Speed Over Ground (SOG), or
 a referenced speed

Calibrating using SOG

For most installations a 1 Point Speed Calibration is
all that is required.

If the 1 point calibration does not provide sufficiently
accurate readings or you require a higher level of
precision for your speed readings then a Speed Run
Calibration can be carried out. It is advisable to carry
out the Speed Run Calibration at as many speeds as
possible. This is particularly important for planing
vessels.

* Conventional speed transducers have a maximum
of 5 calibration speeds, and smart transducers (e.g.
DST800) have up to 8.

If required each calibration point can also have a
calibration factor applied to further align the log
speed reading across different vessel speeds.

Note: * The Speed Run Calibration cannot be
performed when the transducer is connected to

a Speed Pod.

Calibrating without SOG

For most installations a 1 Point Speed Calibration
is all that is required. The calibration must be
performed using a way of estimating actual vessel
speed and adjusting the displayed reading so that
the log speed matches the your estimated speed.

If you do not have SOG data available then the
Speed Run Calibration cannot be performed.

If required, further calibration points can be added
and a calibration factor can be applied to further
align the log speed with actual vessel speed.

iTC-5 Smart (DST) | Speed pod
SOG | No [ SOG | No | SOG | No
SOG SOG SOG
1 ool
vt |V |V |V |V v
calibration
S
caton | v | X || X | X | X
savraion | v | v | v |V |V | v
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1 Point Speed Calibration

For most installations a 1 Point Speed Calibration is
all that is required.

Prerequisites:

* For best results SOG data should be available, or
an alternative method of estimating vessel speed
must be used (e.g. vessel speed can be estimated
using Nautical Measured Mile Markers or similar
landmarks of a known distance apart).

* You will need to be underway, with sufficient space
to maneuver unhindered.

* In order to achieve accurate results, water
conditions must be calm with zero tide and zero
current.

From a favorite page:

1. Select Menu.

2. Select Set-up.

3. Select Transducers Set-up.

4. Select Continue.

The instrument display will search for and display
a list of connected devices. (i.e. iTC-5, DST or
transducer pod)

5. Select the device that the transducer(s) you are
calibrating are connected to.

A list of available transducer data is displayed,
6. * Select Speed.

Important: * Step only applicable to iTC-5.

7. Select Speed Calibration.
8. Select Adjust speed up/down.
The 1 Point Speed Calibration page is displayed.

@ Speed Calibration N

SOG: 5.2 Ktse——1)
Use up/down
keys to adjust
displayed
speed to show
correct value.

o-+4.5 Kis

D13152-1

1. SOG speed reading
2. Current speed reading
If SOG is not available then the SOG value will
display dashes.

9. Accelerate your vessel to a steady, typical
cruising speed.

10.Use the Up and Down buttons to adjust the

current speed reading so that it matches the SOG
reading or matches your estimated speed.

11. Select Done when both values are the same.
The calibration complete page is displayed.

12.Select Ok.

If you experience significant deviation between SOG

and log speed readings at different vessel speeds
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then a Speed Run Calibration should be performed.
Refer to the Performing a Speed Run Calibration
using SOG section for details.

Nautical measured mile markers

When neither SOG data or any other reliable means
of estimating Speed Through the Water (STW) is
available, Nautical Measured Mile Markers can

be used to help calibrate Log Speed. Nautical
measured mile markers are identified by two pairs of
posts or towers. The distance between each pair of
markers is 1 nautical mile.

Each marker in a pair is separated by distance and
elevation from its partner. The front marker is closer
to the water and shorter than the marker behind it.

Markers — side view

D13147-1

1. Front marker
2. Rear marker
When the 2 markers appear vertically aligned

the vessel is on the correct range line to begin a
measured mile run.

Marker alignment

O, E @ ﬁ ® E

D13148-1

1. Left of range line
2. On range line
3. Right of range line

The vessel should already be at top speed and as
the first pair of markers appear aligned a stopwatch
should be started, when the vessel passes the
second pair of aligned markers the stopwatch is
stopped.




Measuring a nautical mile

D13149-1

Starting point (start stopwatch)
Measured mile

End point (stop stopwatch)
First pair of markers

ok wDN -~

Second pair of markers

To provide a more accurate reading the vessel
should make between 4 to 6 runs in both directions
to allow for tide and wind conditions. The average
of the time taken over all runs should be used to
calculate Log Speed.

The vessel speed can then be worked out by taking
the distance travelled (1 nautical mile) and dividing it
by the average time taken to perform the run . The

resulting calculation is your average speed in knots.

Performing a Speed Run Calibration
using SOG

If a higher level of precision is required than

that achieved with the 1 Point Speed Calibration
procedure, a Speed Run Calibration should be
performed. The Speed Run Calibration will ensure
that the Log Speed reading is accurate over the
vessel’s full speed range.

Prerequisites:
» SOG data must be available.

* You will need to be underway, with sufficient space
to maneuver unhindered.

* In order to achieve accurate results, water
conditions must be calm with zero tide and zero
current.

Note: Speed Run Calibration is not available when

connected to a Speed Pod.

The steps below detail the method of calibrating:
» speed transducers connected via an iTC-5

» the speed element of a smart transducer
connected directly to the SeaTalkng network.

From a favorite page:

1. Select Menu.

2. Select Set-up.

3. Select Transducers Set-up.
4. Select Continue.

The instrument display will search for and display
a list of connected devices. (i.e. iTC-5, DST or
transducer pod)

Transducer calibration

5. Select the device that the transducer(s) you are
calibrating are connected to.

A list of available transducer data is displayed,
6. * Select Speed.

Important: * Step only applicable to iTC-5.

7. Select Speed Calibration.
8. Select New cal using SOG.

You will need to add calibration points at a range
of speeds spanning the full speed range of the
vessel. Conventional transducers can have up to
5 calibration points and smart transducers can
have up to 8. Ideally the calibration points should
be taken at regular increments throughout the
speed range with the last calibration point being
close to the vessel’s top speed.

®© o 66 ©®© 6

o | | | |

ONONONONOMOMONO,

With the Speed Transducer connected to a
Speed Pod the 5 calibration points are fixed in
sequence at 2, 4, 8, 16 and 32 knots. When
adding calibration points during the Speed Run
Calibration ensure vessel speed is as close to
the fixed calibration point speeds as possible, as
the calibration factor applied will be the difference
between the actual vessel speed and the fixed
calibration point speed.

9. Select Start.

10.Ensure the vessel's speed is steady at your first
calibration point speed and select Add.

11. Repeat step 10 for all remaining calibration
points, ensuring that the calibration points are
equally spaced throughout your vessel’s speed
range from stationary to top speed.

Once all calibration points have been successfully
added the Calibration complete message is
displayed.

12.Select Ok.

50 kts
~a

Calibration Table

By default Speed Transducers include a default
set of calibration points which are overwritten
during the normal speed calibration process. The
calibration points are stored in the Calibration Table.
The Calibration Table can be accessed from the
Advanced Menu.

From the Advanced Menu you can:
* View the existing Calibration Table

+ Adjust the existing calibration points (Add, Edit or
Delete calibration points)

» Enter a new Calibration Table
» Check Log Speed against SOG
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* Reset the Calibration Table to factory defaults

Viewing the calibration Table
Calibration points are stored in the Calibration Table.

From a favorite page:

1. Select Menu.

2. Select Set-up.

3. Select Transducers Set-up.
4. Select Continue.

The instrument display will search for and display
a list of connected devices. (i.e. iTC-5, DST or
transducer pod)

5. Select the device that the transducer(s) you are
calibrating are connected to.

A list of available transducer data is displayed,
6. * Select Speed.

Important: * Step only applicable to iTC-5.

7. Select Speed Calibration.
Select Advanced.
9. Select View cal table.
The Calibration Table is displayed.

4 Speed Calibration Y @_./ ] Speed Calibration
Uncal. Factor  Calibrated PaddleWheel Prev. New

o

2.0Kts  x1.00 2.0Kts 06Hz 0.6Kts -
4.0Kts  x1.00 4.0Kts 51Hz 1.8Kts --
8.0Kts  x1.00 8.0Kts 11.9Hz 34Kts --

D13153-1

1. Speed transducer connected via iTC-5 or
speed pod.

2. Smart DST transducer connected directly to
SeaTalkns.

10.Use the Up and Down buttons to scroll up and
down through the table.

11. Select Back to return to the Advanced Menu.

Checking speed

The current speed can be checked at any time from
the Advanced Menu.

From the Advanced Menu:
1. Select Check speed.
The Check Speed page is displayed:

Speed [ 5

SOG 8o
I
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Speed

The Check Speed page can also be accessed from
the Edit calibration options menu: Advanced >
Adjust cal table > Start > Options > Check speed.

Manually working out a Calibration Factor

New Calibration Factors can be worked out manually
following the steps below.

* You will need to be underway, with sufficient space
to maneuver unhindered.

» To ensure accuracy, water conditions should be
calm with zero tide and zero current.

* You will need to calibrate each calibration speed
point, starting with the lowest

1. In calm conditions with zero tide and zero current,
run your vessel at a steady speed, approximately
that of the selected calibration speed, over a
measured distance.

Make a note of:
« The measured distance in nautical miles
» The current speed value in knots

¢ The time in minutes it takes to cover the
measured distance

2. Calculate the actual speed over the measured
distance using the calculation: (Speed = (60 x
Distance) / Time) The ‘60’ is used to ensure the
calculation is in minutes rather than hours or
tenths of an hour.

e.g. Distance = 14 nautical miles, Time = 105
minutes (1 hour 45 minutes) so:

+ S=®60xD)/T
+ S=(60x14)/105
+ S=840/105
+ S=8Kits
3. If the calculated speed is:

* The same as the current speed, (noted during
the Speed Run Calibration) then the calibration
is correct at this speed so no action is required.

* Not the same as the current speed. Calculate
a new, corrected Calibration Factor, as follows:
e.g. if actual speed equals 8 kts, indicated
speed was 7.5 kts and the old Calibration
Factor was 1.4 then:

— new cal factor = actual speed x old factor /
indicated speed

— new cal factor=8x14/7.5
— new cal factor=11.2/7.5
— new cal factor = 1.49

Adding a Calibration Point

Calibration Points can be manually added to the
Calibration Table. The amount of Calibration Points
that can be stored is determined by the type of speed
transducer and method of connection.

From the Transducer found menu: Menu > Set-up >
Transducer set-up > Continue :



1. Select the device that the transducer(s) you are
calibrating are connected to.

A list of available transducer data is displayed,
2. * Select Speed.

Important: * Step only applicable to iTC-5.

Select Speed Calibration.

Select Advanced.

Select Adjust Calibration.

Select Start.

The current Calibration Table is displayed.

7. Select the relevant Calibration Point from the
table.

8. Select Options.

9. Select Add cal point.

10.Use the Up and Down buttons to adjust the
displayed Log Speed to match SOG, if available
or to match your estimated actual speed.

11. Select Add.

12.Select Ok.

13.Repeat steps 7 to 11 for each Calibration Point
you want to add.

o0k w

The more Calibration Points the higher the
accuracy of Log Speed.

4. Select Yes to delete.

The Calibration Point is deleted from the
Calibration Table.

Resetting the Calibration Table

The Calibration Table can be reset to factory default
values by following the steps below:

From the Advanced Menu:

1. Select Reset to defaults.

2. Select Yes.

3. Select Ok.

The Calibration Table is reset to factory default
values.

Entering a new Calibration Table

A new Calibration Table can be added manually. The
new Calibration Table replaces the existing table

which is deleted. This is useful when you have been
provided a specific calibration table for your hull type.

Note: You will need to work out your Calibration
Factors for each Calibration Point before you can

create the new Calibration Table.

Note: If the text appears red then the new reading
deviates too far from the stored reading. You will
need to add a Calibration Point closer to the stored
reading a try again.

Editing a Calibration Point

Existing Calibration Points can be manually edited.
From the Advanced Menu:

1. Select Adjust cal table.

2. Select Start.

3. Highlight the relevant Calibration Point from the
table.

Select Options.

5. Select Edit cal point.
The Calibration Point Adjustment page is
displayed.

6. Use the Up and Down buttons to adjust the

Calibration Factor for the selected speed to
match your new Calibration Factor.

Select Done to return to the Calibration Table.

8. Repeat steps 4 to 7 for all Calibration Points that
require adjustment.

9. Select Finish when all of the required Calibration

Points have been adjusted.

&

~

Deleting a Calibration Point

Calibration Points can be deleted from the Calibration
Table.

From the Adjust cal table menu:

1. Select Start.

2. Highlight the Calibration Point you want to delete.
3. Select Options.

Transducer calibration

From the Advanced Menu:
1. Select Enter new cal table.
2. Select Start.

All existing Calibration Points are deleted and you
will be prompted to enter new Calibration Points.

r D

Enter cal point

N\

2.0Kts

\/

3. Use the Up and Down buttons to select the
desired speed that you want to add a Calibration
Point for.

4. Select Next.

5. Use the Up and Down buttons to adjust the
Calibration Factor to the correct value.

6. Select Done.
7. Select Add to add the next Calibration Point.

8. Repeat steps 3 to 7 for all Calibration Points you
want to add.

9. Select Finish when all Calibration Points have
been added.

10. Select OK.
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Calibrating Water Temperature

The Water Temperature reading can be calibrated
as follows:

You will need an suitable thermometer to measure
the Water Temperature.

From a favorite page:

1. Select Menu.

2. Select Set-up.

3. Select Transducers Set-up.

4. Select Continue.

The instrument display will search for and display
a list of connected devices. (i.e. iTC-5, DST or
transducer pod)

5. Select the device that the transducer(s) you are
calibrating are connected to.

A list of available transducer data is displayed,
6. * Select Speed.

Important: * Step only applicable to iTC-5.

7. Select Current Temperature option.

8. Use a suitable thermometer to measure the
actual water temperature.

9. Use the Up and Down buttons to match the
displayed Water Temperature to the actual Water
Temperature measured by the thermometer.

10.Select Save to save the setting.
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7.4 Wind calibration

Calibrating wind
* You will need to be underway, with sufficient space
to turn in a large slow circle unhindered.

» Conditions should be calm (i.e. a slight sea) and
a steady breeze. Try to ensure the vessel is not
rolling or pitching too much.

From a favorite page:

1. Select Menu.

Select Set-up.

Select Transducers Set-up.

Select Continue.

The instrument display will search for and display

a list of connected devices. (i.e. iTC-5, DST or

transducer pod)

5. Select the device that the transducer(s) you are

calibrating are connected to.
A list of available transducer data is displayed,

6. * Select Wind.

o

Important: * Step only applicable to iTC-5.

7. Select Calibrate Wind Xdcr.

8. Keep the vessel speed below 2 kts and observing
the screen, start to turn the vessel in a circle,
then select Start.

9. Continue turning the vessel in circles until
Complete is displayed on-screen.

If your rate of turn is too fast during calibration,
a Slow Down message is displayed. If this
happens, reduce your rate of turn this can be
achieved by slowing down and / or steering in
a wider circle.

&

D12067-1

10.Select Continue.

11. If required use the UP and DOWN buttons to
manually adjust the vane offset.

12.Press SELECT to complete the calibration
process and save the settings.

If required you can manually adjust each part of the
calibration steps by selecting the relevant options
from the Wind menu.

Aligning the wind transducer

* You will need to be underway, with sufficient space
to turn in a large slow circle unhindered.



+ Conditions should be calm (i.e. a slight sea) and
a steady breeze. Try to ensure the vessel is not
rolling or pitching too much.

From the list of transducers found:

1. Select the device that the transducer(s) you are
calibrating are connected to.

A list of available transducer data is displayed,
2. * Select Wind.

3. * Select Wind.

Important: * Step only applicable to iTC-5.

Important: * Step only applicable to iTC-5.

3. Select Align Wind Xdcr.

4. Now steer your vessel directly into the wind and
select Continue.

D12068-1

Adjusting the wind transducer
You can manually adjust the offset.

* You will need to be underway, with sufficient space
to turn in a large slow circle unhindered.

+ Conditions should be calm (i.e. a slight sea) and
a steady breeze. Try to ensure the vessel is not
rolling or pitching too much.

From the list of transducers found:

1. Steer your vessel directly into the wind

D12068-1

4. Select Wind Xdcr Adjust.

@ Wind Xdcr Adjust N
: /\ Manually adjust
your vane offset.
AWA: 018°S

Back Select

5. Use the Up and Down buttons to adjust the offset
value so that the reported AWA is 0 degrees.

@ Wind Xdcr Adjust D

o

Manually adjust
your vane offset.

7\
18 e

Back Select

6. Select Select.

Adjusting apparent wind speed

To apply a Calibration Factor to the Apparent Wind
Speed (AWS) reading follow the steps below.

» To apply an offset to your AWS readings an
accurate reference for AWS must be used to
compare the instrument’s AWS reading against.

+ Conditions should be calm (i.e. a slight sea) and
a steady breeze. Try to ensure the vessel is not
rolling or pitching too much.

From the list of transducers found:

1. Select the device that the transducer(s) you are
calibrating are connected to.

A list of available transducer data is displayed,
2. * Select Wind.

With your vessel sailing directly into the wind
the Apparent Wind Angle (AWA) should be 0
degrees.

2. Select the device that the transducer(s) you are
calibrating are connected to.

A list of available transducer data is displayed,

Transducer calibration

Important: * Step only applicable to iTC-5.

3. Select App Wind Speed.
The AWS Calibration Factor page is displayed.
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Calibrate Wind Speed

N

1.00

Back Select

4. Use the Up and Down buttons to adjust the
Calibration Factor until the AWS reading matches
your referenced source of AWS.

See Docs for
Manual
Calibration.

AWS: 8.3 Kts

« Calibrate Wind Speed N
/\ See Docs for
Manual
Calibration.
AWS: 8.0 Kts

0.27

N

Back Select

The Calibration Factor default is 1.00 the
Calibration Factor can be adjusted from 0.25 to
2.00.

5. Select Select to save the Calibration Factor.
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7.5 Rudder reference calibration

You can calibrate a rudder reference transducer that
is connected to an iTC-5.

The rudder reference transducer must be connected
to the rudder reference connection of the iTC-5

. Rudder reference transducers connected to an
autopilot must be calibrated using the pilot controller.

Centering the Rudder

Centering the Rudder requires a method of knowing
the Rudder’s actual position.

From a favorite page:

1. Select Menu.

Select Set-up.

Select Transducers Set-up.

Select Continue.

The instrument display will search for and display
a list of connected devices. (i.e. iTC-5, DST or
transducer pod)

5. Select iTC-5.

A list of available transducer data is displayed,
6. Select Rudder.
7. Select Centre Rudder.

AN

@ Centre Rudder N
Centre the rudder and press OK
Rudder
50 50
5 25
0
Back (0]

8. Turn the steering until the Rudder is centred.

The Rudder Reference has indicators on its base
and on the rudder arm, ensure these marks are
lined up.

9. With the Rudder centered, select Ok.
The pointer is zeroed on the display.

« Centre Rudder D
Centre the rudder and press OK
Rudder
50 50
25 25
(
Back (0].¢



10. Select Back to return to the Rudder Calibration
Menu.

Adjusting the Rudder Angle

You can manually adjust the Rudder Angle.

Manual adjustment of the Rudder Angle requires a
method of knowing the Rudder’s actual position.
From the transducers found page:
1. Ensure that the rudder is centered centred
2. Select iTC-5.

A list of available transducer data is displayed.
3. Select Rudder.
4. Select Adjust Rudder Angle.

« Adjust Rudder Angle N

Rudder
50 50

1°P

5. Use the Up and Down buttons to adjust the
pointer so that the pointer and the reported
Rudder Angles are both zero.

6. Select Save.

Inverting the Rudder

If the display’s Rudder Pointer moves in the opposite
direction (i.e. when you turn the Rudder starboard
the pointer moves port) this can be corrected by
inverting the Rudder.

From the transducers found page:

1. Ensure that the rudder is centred.

2. Select iTC-5.

A list of available transducer data is displayed.
Select Rudder.

Select Invert Rudder Angle.

5. If the pointer is pointed in the opposite direction
than that expected, select Invert .

o

Transducer calibration

7.6 Compass calibration

You can calibrate a Fluxgate Compass that is
connected to an iTC-5.

The compass must be connected to the compass
connection of the iTC-5. Compasses connected
to an autopilot must be calibrated using a Pilot
Controller.

Swinging the Compass

You will need to turn your vessel in slow circles while

the system automatically makes adjustments to

account for Compass Deviation. Each 360-degree
circle should take no less than two minutes, and you
should complete at least two circles.

It is recommended that a second instrument display

or MFD is used to display heading data, whilst

performing the Compass Swing.

From a favorite page:

1. Select Menu.

2. Select Set-up.

3. Select Transducers Set-up.

4. Select Continue.

The instrument display will search for and display
a list of connected devices. (i.e. iTC-5, DST or
transducer pod)

5. Select iTC-5.

A list of available transducer data is displayed,

. Select Compass.

Select Swing Compass.

8. Start moving vessel in slow even circles, then
press Start.

9. Keep vessel speed to below 2 knots. Watch the
display to ensure your turn rate is not too fast. If
the message ‘Slow Down — turn rate too fast’ is
displayed reduce your rate of turn, this can be
achieved by slowing down and / or steering in
a wider circle.

~N o

If the 'Slow Down — turn rate too fast' message
is displayed the current circle will have to be
repeated.

When the Compass has been calibrated, a
message will be displayed showing the detected
Compass Deviation.

\

/

Swing Compass

Task Complete
Deviation = 2°

o
<V

10.If the deviation is greater than 15 degrees you will
need to relocate the Compass further away from
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metal items or items that may cause interference,
then repeat the calibration process. If you still
find a deviation of more than 15 degrees, contact
your Raymarine dealer for advice. If the deviation
is within acceptable limits, press Cancel.

Setting the Compass Offset

You can manually apply an offset to the Compass
heading by following the steps below.

To apply an offset you require a source of heading
such as the ship’s compass.

From the transducers found page:

1.
2.

ook w
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Ensure that the Rudder is centred

Select iTC-5.

A list of available transducer data is displayed.
Select Compass.

Select Compass Offset.

Steer your vessel on a steady course.

Use the Up and Down buttons to adjust the
Compass Offset until the displayed heading
matches the heading of the ship’s compass.

Select Save.



Chapter 8: Favorite Pages
Chapter contents

» 8.1 Favorite pages on page 54
» 8.2 Customizing pages on page 54

Favorite Pages
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8.1 Favorite pages

The unit displays data on Favorite pages. The
Favorite pages displayed are dependent on the Boat
Type selected during the Startup Wizard.

Depth FEET|

45,

" 452

D12070-2

Selecting pages

1. Use the Up and Down buttons to cycle through
the available pages.

Alternatively you can use the Rollover feature: (Menu
> Favorite Pages > Rollover) to automatically cycle
through the available pages.
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8.2 Customizing pages

Favorite pages can be customized from the
Favorites page menu. You can:

» Edit an existing page.
* Add new pages.

* Delete pages.

» Change page order.

» Set pages to Rollover

Editing an existing page
The layout and data displayed on each page can
be changed.

With the page that you want to edit displayed
onscreen:

1. Select Menu.

2. Select Quick Options.

3. Select Edit Page.

4. Select the page that you want to edit.

Edit Page 4

Depth

Speed
v
Select

Use the Up and Down buttons to highlight the
cell that you want to change.

6. Press the Menu button to choose a new data
item.

Select a data item category.
8. Select the data item/layout from the category list.

AWA & AWS

e ]
Cancel

o

N

If a data item cannot be displayed in the selected
cell it will be grayed out.

9. Follow steps 5 to 8 for the remaining cells that
you want top change.

10.When finished highlight the onscreen tick and
select Save.

The Edit page menu is also available from the
Favorite Pages menu: (Menu > Favorite Pages
> Edit Page).

Adding a page

You can add new custom Favorite pages.

The maximum number of Favorite pages is 10.
From the Main menu:

1. Select Favorite Pages.

2. Select New Page from the menu.

If you already have 10 Favorite pages, you
cannot add another page without first deleting



one of the existing pages. Otherwise you will be
taken to a page layout option screen.

Select the required layout.
Select a cell.

5. Browse the Data Categories list and select the
Data item that you want to display in the selected
cell.

6. Complete steps 2 and 3 for all remaining cells.

7. When finished highlight the onscreen tick and
select Save.

The new page is added to the bottom of the current
set of Favorite pages.

B w

Deleting a page
To delete a page follow the steps below.
The minimum number of Favorite pages is one.

From the Favorite Pages menu: (Menu > Favorite
Pages).
1. Select Delete Page.

If you have two or more pages you will be able
to delete a page.

2. Select a the page that you want to delete.
3. Select Yes.

The page is now deleted.

Changing the page order

From the Favorite Pages menu: (Menu > Favorite
Pages).

1. Select Page order.

2. Select the page you wish to move.

Page numbers are shown momentarily when you
manually cycle through Favorite pages.

3. Use the Up and Down buttons to select the new
location for the page.

4. Select Save.

Setting page Rollover

Using the Rollover feature enables the Favorite
pages to cycle automatically.

From the Favorite Pages menu:

1. select Rollover.

2. Select a Time interval, or .

The Time intervals available are: 2 Secs, 5 Secs,
and 10 Secs.

3. Select Off to switch Rollover off.

Resetting accumulative data

Minimum, Average, Maximum and distance data
accumulates over time and can be reset.

The data item you want to reset must be displayed
onscreen either as part of a Favorite page or as a
Data (Quick view) page.

1. Press the Menu button.

Favorite Pages

2. Select Quick Options.
3. Select the relevant Reset options.
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Chapter 9: Data (Quick View)

Chapter contents

* 9.1 Data items on page 58

* 9.2 Viewing Data (Quick View) on page 60

* 9.3 Adding a Quick View as a Favorite page on page 61

Data (Quick View)
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9.1 Data items

The table below shows a list of possible data items
available to display on Favorite Pages and using
the Data (Quick View) menu.

your system.

Note: The data described in the table below is
dependent on the devices that are connected to
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+ Qil Temperature

+ Coolant
Pressure

+ Coolant
Temperature

+ Boost Pressure
+ Load

+ Alternator
Potential

+ Transmission
Oil Pressure

+ Transmission
QOil Temperature

+ Transmission

+ 2 Engine
Overview

Favorite Page Quick View (Data
Data Category (Data Items) Items)
AIS « AIS « AIS
Battery (1) + Battery Current | » Battery Current
+ Battery * Battery
Temperature Temperature
+ Battery Volts + Battery Volts
Boat + Rate of Turn * Rate of Turn
« Tilt « Tilt
+ Trim Tabs
+ Gray Water
Tank
+ Black Water
Tank
* Fresh Water
Tank
Depth * Depth * Depth
+ Max Depth + Depth History
* Min Depth + Max Depth
+ Depth History |+ Min Depth
Distance * Log * Log
« Trip + Trip
Engine () * Engine Hours |+ Boost Pressure
+ Trim Position + Coolant
. RPM Pressure
* Qil Pressure ' 'cl':grzlslg:ature

* Engine Hours
* RPM

* QOil Pressure

* Qil Temperature
+ Trim Position

* Load

+ Alternator
Potential

+ Transmission
Oil Pressure

+ Transmission
Oil Temperature

+ Transmission

*+ 2 Engine
Overview

Favorite Page Quick View (Data
Data Category (Data Items) Items)
* 1 Engine * 1 Engine
Overview Overview
Environment + Sea * Air Temperature
Temperature * Air Temperature
+ Max Sea History
Temperature * Barometric
* Min Sea Pressure
Temperature . Barometric
+ Sea Pressure
Temperature History
History + Dew Point
* Barometric . Drift
Pressure
* Barometric * Drift History
Pressure * Humidity
History « Min Al
* Air Temperature Temperature
+ Max Air + Max Air
Temperature Temperature
* Min Air + Sea
Temperature Temperature
* Air Temperature [« Min Sea
History Temperature
+ Sunset / + Max Sea
Sunrise Temperature
+ Set + Sea
. Pri Temperature
Drift History
« Wind Chill
Apparent Se
+ Wind Chill True | " SetHistory
. Dew Point + Set & Drift Pair
. + Sunset /
Humidity Sunrise
+ Wind Chill
Apparent

+ Wind Chill True

Fuel ()

Fuel management
is dependent on
engine data that
is available on
SeaTalkng®,

+ Distance To
Empty

* Fuel Flow Rate

* Fuel Flow Rate
Total

* Fuel Flow -
Average

+ Fuel Economy
+ Total Fuel

+ Est. Fuel
Remaining

* Fuel Level
* Fuel Pressure

+ Distance To
Empty

+ Fuel Flow Rate

+ Fuel Flow Rate
Total

* Fuel Economy

*+ Fuel Flow -
Average

+ Fuel Level
+ Total Fuel

+ Est. Fuel
Remaining

¢+ Fuel Pressure




Favorite Page Quick View (Data Favorite Page Quick View (Data
Data Category (Data Items) Items) Data Category (Data Items) Items)
GPS + SOG + COG Navigation + Active Waypoint | « Active Waypoint
. SOGHistory |+ COG History Name Name
. Max. SOG . COG and SOG + Waypoint ID + Waypoint ID
. Avg. SOG . HDOP . ggg:jse Made |- ggggse Made
» €06 + Latitude + CMG&DMG |+ CMG History
+ COG History * LAT & LON . CMG&VMG |- BTW
* COGand SOG |+ Longitude . Distance Made |+ DTW
* Latitude « SATS Good . BTW &DTW
+ LAT & LON + SATS + HDOP « BTW . Distance Made
+ Longitude + SOG « BTW&DTW Good
« SATS + SOG History « DTW « CMG & DMG
« HDOP « Max. SOG « XTE « CMG & VMG
« SATS+HDOP |-+ Avg. SOG « ETA + Course to Steer
Heading *+ Heading * Heading ¢ TTG « CTS&XTE
* Heading & * Heading & + Course to Steer |+ ETA
speed speed . CTS&XTE |+ TTG
+ Heading History | = Heading History + Rolling Road . XTE
* Locked Heading | * Locked Heading . Turn + XTE History
) Egggif]‘gmked ' Egggiﬁgmked + Tum&DTW |+ Roling Road
+ Tack Heading |+ Tack Heading * Tum
+ Heading *+ Heading * Tum & DTW
(Multi-gauge) (Multi-gauge) Pilot * Pilot Heading * Pilot Heading
* Pilot Heading & [ « Pilot Heading &
Speed Pair Speed Pair
+ Pilot Status * Pilot Status
* Rudder Angle |+ Rudder Angle
Speed + Speed + Average Speed

Data (Quick View)

+ Trolling Speed
+ Max Speed

* Average Speed
+ VMG Windward
« VMG WPT

+ Boat Speed &
SOG

+ Speed History

+ Boat Speed &
SOG

+ Max Speed

+ Speed

+ Speed History
+ Trolling Speed
+ VMG Windward

+ VMG Windward
History

+ VMG WPT

« VMG WPT
History
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Favorite Page Quick View (Data
Data Category (Data Items) Items)
Time + Local Time + Clock
+ Time & Date * Local Time
+ Clock + Time & Date
+ Race Timer + Race Timer
Wind « AWS « AWA
+ AWS History + AWA History
* AWS Min « AWA & AWS
+ AWS Max « AWA (CH) &
. AWA AWS
. AWA & AWS « AWA & VMG
. AWA (CH)& | AVWAMax
AWS « AWA Min
« AWA & VMG « AWS
+ AWA History + AWS History
« AWA Min « AWS Max
+ AWA Max « AWS Min
« TWS + Beaufort
+ TWS History + Cardinal
« TWS Min « GWD
+ TWS Max + GWD History
« TWA « GWD &
. TWA & TWS Beaufort
. TWA(CH)& | TP
TWS « TWD History
« TWA& VMG « TWA
+ TWA History « TWA History
« TWA Min « TWA&TWS
+ TWA Max « TWA (CH) &
. GWD TWS
. GWD & « TWA& VMG
Beaufort « TWA Max
+ GWD History « TWA Min
+ Cardinal « TWS
* Beaufort « TWS History
« TWD « TWS Max
« TWD History « TWS Min

Note: (1) There may be more than one device
configured, Data items will be available for each
configured device.
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9.2 Viewing Data (Quick View)

You can use the Data (Quick View) menu to
view data that may not be available on the current
Favorite Pages.

1. Select Data (Quick View) from the main menu.
2. Select a Data Category.

3. Select the Data item and your preferred graphic
type, if available.

The data will be displayed full screen.



9.3 Adding a Quick View as a
Favorite page

The Quick View data pages can be added as a
Favorite page.
From the Data (Quick View) menu:

1. Select the Data item so that it is displayed
onscreen.

2. Press the Menu button.
3. Select Quick Options.
4. Select Add to Favorites.

Data (Quick View)
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Chapter 10: AIS

Chapter contents

AIS

10.1 AIS Overview on page 64

10.2 AIS target symbols on page 65

10.3 Setting AIS Range on page 66

10.4 Viewing AIS target information on page 66

10.5 Enabling and disabling AIS Silent mode on page 67
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10.1 AIS Overview

When an AIS receiver/transceiver is connected

to your system, the AIS feature enables you to
receive information broadcast by other AIS equipped
vessels, and to view these vessels as targets
relative to your boat. The AIS feature on the unit is
standalone, settings and alarms cannot be shared
with other AIS enabled products on your system.

How AIS Works

AIS uses digital radio signals to broadcast ‘real-time’
information between vessels and shore-based
stations via dedicated VHF radio frequencies. This
information is used to identify and track vessels in
the surrounding area and to provide fast, automatic
and accurate collision avoidance data.

AIS Messages

Note: It is not mandatory for vessels to be fitted
with operational AIS equipment. Therefore, you
should not assume that ALL vessels in your area

AIS Messages Description

AIS off AIS Unit off

(none) AIS is on and transmitting

Alarm on icon AIS on, transmitting, alarm is
active.

Silent AIS on & user is silent to
other vessels.

Alarm on AIS on, user is silent to other
vessels & alarm is active.

Alarm off icon AIS on & Alarm off

Data lost AIS on & data lost.

No fix AIS on & lost GPS fix.

Insufficient COG/Hdg data got stable COG or heading

ata

are displayed.

With an optional AIS unit connected to your system
you can:

» Display targets for any other AlS-equipped
vessels.

» Display voyage information being broadcast by
these targets, such as their position, course,
speed and rate-of-turn.

 Display basic or detailed information for each
target vessel, including safety-critical target data.

» Set up a safe zone around your vessel.
* View AIS alarm and safety-related messages.

AIS information is displayed on the screen as shown
below:

oAlS off o~

I

§ 6o

D12078-2

Item Description

1 AlS text
See AIS messages in table
below

AIS target

Dangerous targets alarm on

Heading line

COG line

(o228 IS 1N BE ~ A RSV TN I \G)

Dangerous targets alarm off

Note: Where unstable or no heading or COG data
is available AIS targets and your vessel icon will

not be displayed.
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AlS-equipped vessels in the surrounding area are
displayed on the page as targets. A maximum of 25
targets can be displayed, where more than 25 targets
are in range Max targets is displayed onscreen.



10.2 AIS target symbols

Your display shows a range of symbols to represent
the different types of AIS target.

Target type

Description

dangerous or lost.
Target is moving or
at anchor.

Target type Description Symbol
Transmitting target | Target not
activated, A

Aid To Navigation
(AToN) target
(Virtual)

AToN target is
OFF position &
lost. Target black
with red cross and
flashes.

Land base station
target

Land base station
target is ONLINE.

Selected target

Target selected
with cursor. Can

Yacht Target vessel type
is a yacht.

Commercial Target vessel type

Vessel is a commercial

vessel.

High speed vessel

Target vessel type
is a high speed
vessel.

view detailed data. A
Dangerous target | Targets within \ /
specified distance ~ _ -
(CPA) or P %
time (TCPA).
Dangerous target
alarm sounds if
enabled. Target
red and flashes.
Uncertain target Calculated CPA &
/ TCPA value f
uncertain. -
Lost target When signal of \
dangerous target ~ %"'
not received for 20 A
seconds. Target
in latest predicted
position. Alarms
sounds if enabled.
Target with red
cross and flashes.
Aid To Navigation | AToN target is ON <_|>
(AToN) target position.
(Real)
Aid To Navigation | AToN targetis OFF @
(AToN) target position. Target
(Real) red.
Aid To Navigation | AToN target is |
(AToN) target OFF position & ~ @/
(Real) dangerous. Target P N
black and flashes. !
Aid To Navigation | AToN target is |
(AToN) target OFF position & ~ -
(Real) lost. Target black /&\
with red cross and !
flashes.
Aid To Navigation | AToN target is ON <\>
(AToN) target position.
(Virtual)
Aid To Navigation | AtoN target is OFF @
(AToN) target position. Target
(Virtual) red.

Aid To Navigation
(AToN) target
(Virtual)

AToN target is
OFF position &
dangerous. Target
black and flashes.

AIS
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10.3 Setting AIS Range

The distance displayed on the AIS page can be
adjusted.

With the AIS page displayed:

1. Press the Menu button.

2. Select Quick options .

3. Select AIS Range.

4. Select the Range you want to display.
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10.4 Viewing AIS target
information

You can view information about AIS targets.
With the AIS page displayed:

1.

2.
3.
4.

Press the Menu button.
Select Quick Options.
Select View AIS targets.

Use the Up and Down buttons to select an AIS
target.

The Name of the vessel will be displayed in the
page header.

Select Info to view detailed target information.

The information displayed is dependent on he
type of target selected.

* Vessel name
* MMSI number
* Vessel type

» Call sign

+ SOG

Use the Up and Down buttons to scroll through
the data.

To return to the AIS page, select Back .



10.5 Enabling and disabling AIS
Silent mode

AIS silent mode enables you to disable the
transmitting functions of your AIS equipment. This
is useful when you do not want to transmit your
vessel’s AlS data to other AIS receivers, but still wish
to receive data from other vessels.

Note: Not all AIS equipment supports silent mode.
For more information, refer to the documentation

that accompanied your AIS unit.

From the AIS page:

1. Press the Menu button.
2. Select Quick options.
3. Select AIS Silent mode.
4

. Select Silent to stop your AIS position and details
being transmitted, or

5. Select Transmit to allow your AlS position and
details to be received by other AIS equipped
vessels.

AIS
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Chapter 11: Race timer settings
Chapter contents

* 11.1 Setting the Race Timer on page 70
* 11.2 Using the Race Timer on page 70

Race timer settings
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11.1 Setting the Race Timer

The Race Timer is used to show the time elapsed
since the start of a race. The Race Timer has 3
countdown timers. When a timer count down is
complete (reaches zero) then the Race Timer will
start to count up.

If the Race Timer has not been added as a Favorite
Page then it can be accessed from the Data (Quick
View) menu: Menu > Data (Quick View) > Time

> Race Timer.
2

Race Timer

9:

n

5
Start

With the Race Timer page displayed:
Press the Menu button.

Select Quick Options.

Select Adjust start timers.
Select a start timer

Use the Up and Down buttons to adjust the timer
to the required value.

Select Save.

7. Complete steps 4 to 6 for each start timer you
want to adjust.

ok ownd-~

o
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11.2 Using the Race Timer

With the Race Timer page displayed:

1. Select Start.
The first star timer will begin to count down,
audible beeps are sounded as follows:
* Double beep every minute.

» Beep Three times at the start of the last 30
seconds.

* Beep every second for the last 10 seconds.

* Beep for two seconds when the timer reaches
zero

2. You can select Skip to skip to the next start timer.

With the third start timer counting down you can
select Count up to start the timer counting up
from zero.

3. You can stop the start timer count down by
selecting Stop from the Quick Options menu.

4. When stopped, you can resume the count down
by selecting Resume.

5. The Race Timer page can be reset by selecting
Reset Timer from the Quick Options menu.

Note: You can view other Favorite pages and

menus whilst the Race Timer is running.




Chapter 12: Instrument alarms

Chapter contents
* 12.1 Alarms on page 72

Instrument alarms
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12.1 Alarms

Alarms are used to alert you to a situation or hazard
requiring your attention.

Some examples of alarms are:

* Anchor alarm — Used when anchored, this alerts
you to a change in depth which could mean that
the chain length requires adjusting.

» Depth and speed alarms — These alarms alert
you when your depth or speed moves outside of
specified limits, for example a minimum depth.

+ MOB (Man Overboard) alarm — Received from an
MOB system.

When an alarm occurs, a message is displayed and
an audible alarm may sound.

Off course Alarm
Tum to Starboard

D12080-1

You can either:
+ Silence the alarm, or
+ Silence the alarm and edit the alarm settings.

Alarm settings

Most alarms are generated locally using specified
thresholds. They are also transmitted to the
SeaTalk and SeaTalkns networks for display at other
compatible devices.

Category Alarm Content

Shallow Alarm + On

« Off (de-
fault)

Depth

0 — xxx
FT

+ 5

ft (default)

Adjust .

Alarm * On

« Off (de-
fault)

Depth Deep

Adjust ¢ 0 — xxx

FT

+ 100
ft (default)

Note: With the exception of the Alarm clock,
Speed and Sea temperature; SeaTalk systems will
only be able to switch alarms on and off, SeaTalkng

Depth Shallow

Anchor

Alarm * On

+ Off (de-
fault)

0 — xxx
FT

+ 5

ft (default)

Adjust .

systems will also be able to adjust settings.

Man over Board (MoB) alarm

In the event of a MOB alarm, the instrument provides
details to help find the MoB target.

m’** Man Over Board
Brg: 226°M
Rng: 358m
00:01:27

* Brg: Bearing to MoB waypoint.
* Rng: Range to MoB waypoint.
» Elapsed time since start of MoB alarm.

Bearing and Range require GPS data to be available
on the network.
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Depth Alarm * On

« Off (de-
fault)

Deep
Anchor

Adjust o 0 — xxx

FT

+ 100
ft (default)

Alarm + On

« Off (de-
fault)

Speed Boat Speed

High

Adjust + 0—100

KTS

+ 30 kts (de-
fault)

Alarm + On

+ Off (de-
fault)

Speed Boat Speed

Low

Adjust + 0—100

KTS
+ 5 kts (de-

fault)




Category Alarm Content Category Alarm Content
Temperature | Sea Temp. | Alarm « On Wind TWS Low Alarm « On
High . Off (de- qe Wi . Off (de-
fault) P fault)
Adjust + 0—50°C Adjust « 0—200
+ 10°C (de- KTS
fault) * 10 kts (de-
fault)
Temperature | Sea Temp. | Alarm * On
Low . i Wind TWA High | Alarm * On
foaﬁlt()de True Wind . Off (de-
Angle high fault)
Adjust « 0—50°C
. 19C (de- Adjust « 0—180°
fault) « 25° (de-
Wind AWS High | Alarm . On fault
Apparent « Off (de- Wind TWA Low Alarm « On
Wind Speed fault) True Wind « Off (de-
high Angle low fault
Adjust « 0—200
KTS Adjust « 0—180°
o 25 kis (de- « 10° (de-
fault) fault)
Wind AWS Low Alarm « On Other Alarm Clock | Alarm « On
Apparent
' « Off (de- « Off (de-
Wind Speed fault fault)
low
Adjust « 0—200 Time « 12:00 am
KTS —12:00
« 10kts (de- pm
fault) + 00.00 -
Wind AWA High | Alarm . On 2359 24
Apparent . Off (de-
Wind Angle faul Format 24 hour
high ault) /
Adjust .« 0—180° am/pm
. 25° (de- Other Off Course | Alarm * On
fault) « Off (de-
Wind AWA Low | Alarm . On fault
Apparent . Adjust « 0—180°
Wind Angle ?ﬁ (de- 0
low ault) . f5 |(de-
Adjust . 0—180° ault)
. 100 (A Other MOB Alarm * On (de-
f1aou|t§Ole Man fault)
Overboard . Off
Wind TWS High Alarm « On
True Wind . Off (de- Other Battery Low | Alarm * On
Speed high
fault) + Off (de-
Adjust « 0— 200 fault)
KTS Adjust - 6-60V
10 kts (de- « 10
fault) V (default)

Instrument alarms

73



Category

Alarm

Content

Other

AIS Alarm

Safety
messages

« Off (de-
fault)

Dangerous
target

* On

« Off (de-
fault)

Safe zone

« (01,02,
0.5, 1.0,
2.0) nm

. (01,02,
0.5, 1.0,
2.0) sm

+ (0.2, 0.5,
1.0, 2.0,
5.0) km

Time to safe
zone

« 3 min
* 6 min
* 12 min
+ 24 min
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Chapter 13: Setup menu

Chapter contents
* 13.1 Setup menu on page 76

Setup menu
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13.1 Setup menu

The Set-up menu provides settings to configure the

unit.
Menu item Description Options
Transducer Set up and List of connected,
Set-up calibrate compatible
transducers transducers.
as detailed
in Transducer
calibration section
above.
User Preferences | Configure User + Time & Date
Preferences. . Units
+ Language
* Boat Type
* Boat Details
* Variation
* Key Beep
System set up Configure network | » Network group
' ness/Color
Group

+ Data Sources

+ About System
Set Up

Simulator

Enables and
disables simulator
mode. The
simulator
produces
simulated data

to enable you to
practice operating
the unit.

Note: The
Simulator will
not product
simulated data
if other product
are present on
the SeaTalkng®
network.

« On
« Off

Factory reset

Delete user
settings and
Restore unit to
factory default
settings.

* Yes

Diagnostics

Information About
the unit, device
connected to the
network and a
diagnostics Self
Test.

* About display
* About system
+ Self Test
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Transducer setup menu
The Transducer Set-up menu enables calibration of connected transducers.

Setup menu

Menu item Description Options
iTC-5 Enables setup and calibration of transducers * Depth
connected using an iTC-5. . Speed
+ Wind
¢ Rudder reference
+ Compass
Depth Enables setup and calibration of depth Details displays can supply information about
transducers and provides the following options: | the installed transducer or interface such as
. Detail Serial No. and Software version etc.
etails Depth offset allows you to set the offset
* Depth offset distance so that the displayed depth reading
represents the depth to the sea bed from either
the keel or the waterline.
* Depth from:
- Keel
— Transducer
- Water line
+ Offset:
- 0t099ft,m
+ About depth offset
Speed Enables setup and calibration of speed Details displays can supply information about
transducers and provides the following options: | the installed transducer or interface such as
. Detail Serial No. and Software version etc.
etatls Speed calibration:
+ Speed calibration speed should be . . ,
calibrated at each of the speed points shown spﬁsd t§ett|ng§ tare tdetzrm_ltrrl]ed _byt;]he
under speed calibration. callbration points stored either in tne
transducer or the interface unit.
* Calibrate water temperature Calibrate water temperature:
¢ xxx °C or °F
Wind Enables setup and calibration of wind Details displays information about the installed
transducers and provides the following options: | transducer, Serial No. and Software version etc.
. Wind detail Calibrate vane- follow the on screen instructions
Ind detal to calibrate the wind vane.
+ Calibrate vane App wind speed:
+ App wind speed calibration * xx kits
DST800 Enables setup and calibration of DST (Depth, | DST800 details displays information about the

Speed, and Temperature) smart transducers
and provides the following options:

« DST800 details

+ Depth offset

+ Speed calibration
+ Temperature offset

installed transducer, Serial No. and Software
version efc.

Depth offset allows you to set the offset
distance so that the displayed depth reading
represents the depth to the sea bed from either
the keel or the waterline.

* Depth from:
- Water line
- Keel
— Transducer
+ Offset:
- 0to 99 ft
+ About depth offset
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Menu item

Description

Options

Speed calibration:

+ Add — adds a new speed setting using
current SOG reading.

+ Edit — edits a speed setting in 0.1 kt
increments.

+ Delete — deletes the selected speed setting.

* Reset — resets speed calibration to default
settings.

Temperature offset:

« xxx °C or °F

DT800

Enables setup and calibration of DT (Depth, and
Temperature) smart transducers and provides
the following options:

+ DT800 details
* Depth offset
+ Temperature offset

DT800 details displays information about the
installed transducer, Serial No. and Software
version efc.

Depth offset allows you to set the offset
distance so that the displayed depth reading
represents the depth to the sea bed from either
the keel or the waterline.

* Depth from:
— Water line
- Keel
— Transducer
+ Offset:
- 0t0o 99 ft, m
+ About depth offset
Temperature offset:

¢ xxx °C or °F
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User Preferences menu
The User Preferences menu enables you to customize the unit settings.

+ Temperature
* Flow rate

* Heading

* Pressure

+ Volume

+ Barometric

Menu item Description Options
Time & Date These options enable you to customize the date | Date format:
and time format to your requirements. You can | dd/
also specify a local time offset from Universal mmydalyy
Time Constant (UTC), to compensate for any « dd/mmlyy
time zone difference. .
Time format:
« 12hr
o 24hr
Time offset:
+ -13to +13 hours
Units Enables you to specify the units used for the Speed:
following key measurements:
* kts — knots.
* Speed * mph — miles per hour.
* Distance + km/h — Kilometers per hour.
* Depth Distance:
* Wind speed

« nm — Nautical miles.
+ sm — Statute miles.

¢+ km — Kilometers.

Depth:
o ft — Feet
+ m — Metres

+ fa — Fathoms

Wind speed:

* kts — knots.

* m/s — metres per second.
Temperature:

+ °C — degrees centigrade.
+ °F — degrees fahrenheit.
Flow Rate

+ UK Gal/H — UK gallons per hour.
+ US Gal/H — US gallons per hour.

* LPH — Liters per hour.
Heading:

* Mag — magnetic.

+ True

Pressure

+ PSI — pounds per square inch.
+ Bar — bar.

+ kPa — Kilo pascals.
Volume:

+ UK Gallons

+ US Gallons

o |tr — liter.

Setup menu
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Menu item

Description

Options

Language

Determines the language that will be used for all
on-screen text, labels, menus and options.

English (UK)
English (US)
Chinese
Croatian
Danish
Dutch
Finnish
French
German
Greek

Italian
Japanese
Korean
Norwegian
Polish
Portuguese (Brazilian)
Russian
Spanish
Swedish
Turkish

Boat Type

Determines the default setup of the unit and
favorite pages

Race Sail

Sail Cruiser

Catamaran

Workboat

RIB

Outboard Speedboat
Inboard Speedboat
Power Cruiser 1 (<12kts)
Power Cruiser 2 (<30kts)
Power Cruiser 3 (>30kts)
Sport Fishing

Pro Fishing

Boat Details
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Enable you to specify the following:
* Number of engines

* Number of batteries

* Number of fuel tanks

+ Max RPM range

* RPM Red Zone

Number of engines:

1—5

Number of batteries

1—5

Number of fuel tanks

1—5

Max RPM range

Auto (default)
3000 rpm
4000 rpm
5000 rpm




Menu item

Description

Options

* 6000 rpm

+ 7000 rpm

+ 8000 rpm

* 9000 rpm

+ 10000 rpm
RPM Red Zone
+ Auto (default)
+ Custom value

pressing buttons.

Variation Enables you to turn on and off magnetic Variation mode:
variation, specify slave source or adjust . 0
manually. n
+ Variation mode + Off (default
- + Slave
+ Variation range
Variation range:
+ -30°— +30°
Key Beep Enable and disable the audible beep when + On (default)

+ Off

Setup menu
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System set-up menu

The System set-up menu enables users to customize the following user settings:

Menu item

Description

Options

Network group

Allows adding multiple units together in
a group so that when the color scheme
or brightness is changed on one unit the
changes are applied to all units in the
group.

Predefined groups

* None

* Helm 1

* Helm 2

+ Cockpit

* Flybridge

* Mast

Undefined

+ Group-1 — Group-5

Brightness / color group

Enables synchronization of the displays
brightness and color to be the same as
the other units in the same group.

Sync brightness / color
+ This display
* This group

Data sources

Allows you to view and select preferred
data sources.

+ Select data source
+ Data source found
+ Data source details

Select data source
+ GPS position

+ GPS Datum

+ Time & Date

* Heading

* Depth

+ Speed

+ Wind

Data source found
* model name — serial number Port ID
Data source details
+ Device name

+ Serial No.

« PortID

+ Status or No data

About system set-up

Provides information about the System
set-up menu.
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Diagnostics menu

You can access diagnostics details from the Diagnostics menu: (Menu > Set-up > Diagnostics).

Menu item

Description

Options

About display

Allows you to view information about the display
you are using:

Software version
Hardware version
Bootloader version
Temperature

Volts

Max. volts
Current

Max. current

Run time

Deviation (If available)

About Pilot

Allows you to view information about the
autopilot you are using:

Note: The About Pilot menu is only
available on Pilot controllers.

NMEA Code
Product ID
Serial number
Description
Software version
PCB Number
CAN Volts

Unit Volts
Operating hours

Deviation

About system

Allows you to search the SeaTalkn9 network and
display information about the products found.

Model number
Serial number
Software version
Hardware version
Volts

Self test

The product has a built in self test which can
help to diagnose faults.
Self-Test include:

* Memory test
+ Button test
+ Display test
¢ Buzzer test

* |llumination test

N/A

Setup menu
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Chapter 14: Maintenance

Chapter contents

14.1 Service and maintenance on page 86
14.2 Routine equipment checks on page 86
14.3 Product cleaning on page 87

14.4 Cleaning the display case on page 87
14.5 Cleaning the display screen on page 88
14.6 Cleaning the sun cover on page 88

Maintenance
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14.1 Service and maintenance

This product contains no user serviceable
components. Please refer all maintenance
and repair to authorized Raymarine dealers.
Unauthorized repair may affect your warranty.
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14.2 Routine equipment checks

Raymarine strongly recommends that you complete
a number of routine checks to ensure the correct and
reliable operation of your equipment.

Complete the following checks on a regular basis:

» Examine all cables for signs of damage or wear
and tear.

» Check that all cables are securely connected.



14.3 Product cleaning

Best cleaning practices.
When cleaning products:

* If your product includes a display screen, do NOT
wipe the screen with a dry cloth, as this could
scratch the screen coating.

* Do NOT use abrasive, or acid or ammonia based
products.

* Do NOT use a jet wash.

Maintenance

14.4 Cleaning the display case

The display unit is a sealed unit and does not require

regular cleaning. If it is necessary to clean the unit,

follow this basic procedure:

1. Switch off the power to the display.

2. Wipe the display with a clean, soft cloth (a
microfibre cloth is ideal).

3. If necessary, use a mild detergent to remove
grease marks.

Note: Do NOT use solvents or detergents on the
screen itself.

Note: In certain conditions, condensation may
appear inside the display screen. This will not
harm the unit, and can be cleared by powering on
the display for a short time.
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14.5 Cleaning the display screen

A coating is applied to the display screen. This
makes it water repellent, and prevents glare. To
avoid damaging this coating, follow this procedure:

1. Switch off the power to the display.

2. Rinse the screen with fresh water to remove all
dirt particles and salt deposits.

3. Allow the screen to dry naturally.

4. If any smears remain, very gently wipe the screen
with a clean microfibre cleaning cloth (available
from an opticians).

Transducer care and cleaning

Growth can collect on the bottom of the transducer,
this can reduce performance. To prevent the build-up
of sea growth, coat the transducer with a thin layer
of water-based antifouling paint, available from
your local marine dealer. Reapply paint every 6
months or at the beginning of each boating season.
Certain smart transducers have restrictions on where
antifouling paint is applied. Please consult your
dealer.

Note: Transducers with a temperature sensor may
not work properly if painted.

Note: Never use ketone-based paint. Ketones
can attack many plastics, possibly damaging the
Sensor.

Note: Never use spray paint on your transducer.
Spraying incorporates tiny air bubbles, and a
marine transducer cannot transmit properly

through air.

Use a soft cloth and mild household detergent to
clean the transducer. If the fouling is severe, remove
the growth with a tough cleaning pad, such as a
green Scotch Brite™ pad for example. Be careful to
avoid scratching the face of the transducer.

Note: Harsh cleaning solvents such as acetone

WILL damage the transducer.
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14.6 Cleaning the sun cover

The supplied sun cover features an adhesive surface.
In certain conditions unwanted contaminants may
stick to this surface. To avoid damaging the monitor
display, clean the sun cover regularly following this
procedure:

1. Carefully remove the sun cover from the display.

2. Rinse the sun cover with fresh water to remove
all dirt particles and salt deposits.

3. Allow the sun cover to dry naturally.



Chapter 15: System checks and troubleshooting

Chapter contents

15.1 Troubleshooting on page 90

15.2 Power up troubleshooting on page 91
15.3 System data troubleshooting on page 92
15.4 Miscellaneous troubleshooting on page 93
15.5 Performing a Factory Reset on page 94

System checks and troubleshooting
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15.1 Troubleshooting

The troubleshooting information provides possible
causes and corrective action required for common
problems associated with marine electronics
installations.

All Raymarine products are, prior to packing and
shipping, subjected to comprehensive test and
quality assurance programs. However, if you
experience problems with the operation of your
product this section will help you to diagnose
and correct problems in order to restore normal
operation.

If after referring to this section you are still having
problems with your unit, please contact Raymarine
Technical Support for further advice.
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15.2 Power up troubleshooting

Problems at power up and their possible causes and solutions are described here.

Product does not turn on or keeps turning off

Possible causes

Possible solutions

Blown fuse / tripped breaker

1.

Check condition of relevant fuses and breakers and connections, replace
if necessary (Refer to the Technical Specification section of your product’s
installation instructions for fuse ratings.)

If fuse keeps blowing check for cable damage, broken connector pins or
incorrect wiring.

Poor / damaged / insecure power supply
cable / connections

Check that the power cable connector is fully inserted into the unit and locked in
position.

Check the power supply cable and connectors for signs of damage or corrosion,
replace if necessary.

With the unit turned on, try flexing the power cable near to the display connector
to see if this causes the unit to re-boot/loose power, replace if necessary.

Check the vessel's battery voltage, the condition of the battery terminals and
power supply cables, ensuring connections are secure, clean and free from
corrosion, replace if necessary.

With the product under load, using a multi-meter, check for high voltage drop
across all connectors/fuses etc, replace if necessary.

Incorrect power connection

The power supply may be wired incorrectly, ensure the installation instructions have
been followed.

Power source insufficient

With the product under load, using a multi-meter, check the power supply voltage as
close to the unit as possible to establish actual voltage when the current is flowing.
(Refer to the Technical Specification section of your product’s installation instructions
for power supply requirements.)

Product will not boot up (re-boot

loop)

Possible causes

Possible solutions

Power supply and connection

See possible solutions from ‘Products does not turn on or keeps turning off' above.

Software corruption

In the unlikely event that the products software has become corrupted please try
re-flashing the latest software from the Raymarine website.

On display products, as a last resort, you can try to perform a ‘Power on Reset’,
however this will delete all settings/presets and user data (such as waypoints
and tracks) and revert the unit back to factory defaults.

System checks and troubleshooting
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15.3 System data troubleshooting

Aspects of the installation can cause problems with the data shared between connected equipment. Such
problems, their possible causes and solutions are described here.

Problem

Possible causes

Possible solutions

Instrument, engine or other
system data is unavailable at all
displays.

Data is not being received at the
display.

Check the data bus (e.g. SeaTalkng) wiring and
connections.

Check the overall integrity of the data bus (e.g. SeaTalkn9)
wiring.

If available refer to the reference guide for the data bus
(e.g. SeaTalkng reference manual).

Data source (e.g. instrument
display or engine interface) is
not operating.

Check the source of the missing data (e.g. instrument
display or engine interface).

Check the power to the SeaTalk bus.

Refer to the manufacturer's handbook for the equipment
in question.

Software mismatch between
equipment may prevent
communication.

Contact Raymarine technical support.

Instrument or other system data
is missing from some but not all
displays.

Network problem.

Check that all required equipment is connected to the
network.

Check the status of the Raymarine network Switch.

Check that SeaTalkhs / RayNet cables are free from
damage.

Software mismatch between
equipment may prevent
communication.

Contact Raymarine technical support.

Position data is not displayed on
VHF radio

VHF radio NMEA 0183 input not
isolated / incorrect polarity

+ Check that the radio has an Isolated NMEA 0183 input.
+ Check polarity of NMEA 0183 wires.
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15.4 Miscellaneous troubleshooting

Miscellaneous problems and their possible causes and solutions are described here.

Problem

Possible causes

Possible solutions

Display behaves erratically:
+ Frequent unexpected resets.

+ System crashes or other
erratic behavior.

Intermittent problem with power
to the display.

Check relevant fuses and breakers.

Check that the power supply cable is sound and that all
connections are tight and free from corrosion.

Check that the power source is of the correct voltage and
sufficient current.

Software mismatch on system
(upgrade required).

Go to www.raymarine.com and click on support for the
latest software downloads.

Corrupt data / other unknown
issue.

Perform a factory reset.

Important: This will result in the loss of any settings
and data (such as waypoints) stored on the product.
Save any important data to a memory card before

resetting.

System checks and troubleshooting
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15.5 Performing a Factory Reset

To reset your unit to factory default settings follow
the steps below.

Note: Performing a factory reset will erase all
saved data and customized settings.

Press the Menu button.
Select Set Up.

Select Factory Reset.
Select Yes.

Your unit will now reset itself to factory default
settings.

LN~
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Chapter 16: Technical support
Chapter contents

* 16.1 Raymarine product support and servicing on page 96
* 16.2 Viewing product information on page 97

Technical support
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16.1 Raymarine product support
and servicing

Raymarine provides a comprehensive product
support service, as well as warranty, service, and
repairs. You can access these services through the
Raymarine website, telephone, and e-mail.
Product information

If you need to request service or support, please
have the following information to hand:

* Product name.

* Product identity.

+ Serial number.

» Software application version.

+ System diagrams.

You can obtain this product information using the
menus within your product.

Servicing and warranty

Raymarine offers dedicated service departments for
warranty, service, and repairs.

Don’t forget to visit the Raymarine website to

register your product for extended warranty benefits:

http://www.raymarine.co.uk/display/?id=788.

Region Tele- E-mail
phone
United +44 emea.service@raymarine.com
Kingdom (UK), | (0)1329
EMEA, and 246 932
Asia Pacific
United States | +1 (603) | rm-usrepair@flir.com
(US) 324 7900
Web support

Please visit the “Support” area of the Raymarine
website for:

* Manuals and Documents — http://www.rayma-
rine.com/manuals

* FAQ / Knowledgebase — http://www.rayma-
rine.com/knowledgebase

* Technical support forum — http://forum.rayma-
rine.com

+ Software updates — http://www.rayma-
rine.com/software

Telephone and e-mail support

Region Tele- E-mail
phone

Australia and +61 2 aus.support@raymarine.com

New Zealand 8977 (Raymarine subsidiary)
0300

France +33 (0)1 | support.fr@raymarine.com
46 49 72 | (Raymarine subsidiary)
30

Germany +49 support.de@raymarine.com
(0)40237 | (Raymarine subsidiary)
808 0

Italy +39 02 [ support.it@raymarine.com
9945 (Raymarine subsidiary)
1001

Spain +34 96 | sat@azimut.es
2965 102 | (Authorized Raymarine

distributor)

Netherlands +31 support.nl@raymarine.com
(0)26 (Raymarine subsidiary)
3614 905

Sweden +46 support.se@raymarine.com
(0)317 (Raymarine subsidiary)
633 670

Finland +358 support.fi@raymarine.com
(0)207 (Raymarine subsidiary)
619 937

Norway +47 692 | support.no@raymarine.com
64 600 | (Raymarine subsidiary)

Denmark +45 437 | support.dk@raymarine.com
164 64 (Raymarine subsidiary)

Russia +7 495 [ info@mikstmarine.ru
788 0508 | (Authorized Raymarine

distributor)

Region Tele- E-mail

phone
United Kingdom | +44 support.uk@raymarine.com
(UK), EMEA, (0)1329
and Asia Pacific | 246 777
United States +1(603) | support@raymarine.com
(US) 324 7900

(Toll-free:

+800 539

5539)
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16.2 Viewing product information

Press the Menu button.
Select Set-up.

Select Diagnostics.
Select About Display.

A range of information is displayed, including the
software version and Serial number.

5. Use the Up and Down buttons to cycle through
the information.

PN~
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Chapter 17: Technical specification

Chapter contents
* 17.1 Technical specification on page 100

Technical specification
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17.1 Technical specification

Nominal supply voltage 12V dc
Operating voltage range 9to 16V dc
Current 132 mA
Power consumption 16 W

LEN (Refer to the SeaTalknd | 3

reference manual for further
information.)

Environmental

Operating temperature:
-25°C to 55°C (-13°F to
131°F)

Storage temperature range:
-30°C to 70°C (-22°F to
158°F)

Relative humidity: max: 93%
Water proof to IPX6

Display screen

TFT LCD display, 16bit color
(64k colors)

Resolution: 320x240
Brightness: 700 cd/m?

Data connections

2 x SeaTalkng ports
(fulling compliant with
NMEA2000 & SeaTalk
specifications).

Conformance

+ Europe 2004/108/EC

+ Australia and New Zealand
C-Tick, compliance level 2
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Chapter 18: Options and accessories

Chapter contents

18.1 Spares and accessories on page 102

18.2 Smart transducers on page 102

18.3 Instrument Depth, Speed and Temperature (DST) transducers on page 103
18.4 Instrument Depth transducers on page 104

18.5 Instrument Speed and Temperature transducers on page 104
18.6 Instrument Wind Vane transducer on page 105

18.7 Instrument Rotavecta transducer on page 105

18.8 Other transducers on page 106

18.9 SeaTalkng® cables and accessories on page 106

18.10 SeaTalkng cable kits on page 108

18.11 SeaTalk accessories on page 111

Options and accessories
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18.1 Spares and accessories 18.2 Smart transducers

Part number Description Smart transducers can be connected directly to the
R22168 S bezel SeaTalkn9® backbone without the need for an iTC-5
pare beze or transducer pod.
R22169 Sun cover The smart transducers listed below are compatible
with the following displays:
* i70/i70s
» Multifunction displays
Part
number Mounting Type
A22147 Thru-Hull DT800-12
Bronze
A80374 Thru-Hull DT800-12
(replaces Plastic

A22112)
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18.3 Instrument Depth, Speed and

Part
number Mounting | Type Temperature (DST) transducers
A22146 Thru-Hull DST800
Bronze The DST transducers listed below are compatible
with the following instrument displays:
* i40 Depth / i40 Speed / i40 Bidata
* i50 Depth i50 Speed / i50 Tridata
* i70/i70s via iTC-5 converter
A80375 Thru-Hull DST800 Part
(replaces Plastic number | Image Mounting Housing
A2211) E26006- Transom P66 / ST40
Pz = mount
N
A26043 Thru-hull B744V
(including
fairing block)
A26044 Thru-hull B744VL
(including
§l§\\\“‘j\\\\‘ fairing block)
E26028- Transom P66
Pz mount

Options and accessories
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18.4 Instrument Depth 18.5 Instrument Speed and

transducers Temperature transducers
The depth transducers listed below are compatible The speed and temperature transducers listed below
with the following instrument displays: are compatible with the following instrument displays:
* i40 Depth / i40 Bidata * i40 Speed / i40 Bidata
* i50 Depth / i50 Tridata » i50 Speed / i50 Tridata
* i70 /i70s via iTC-5 converter * i70/i70s via iTC-5 converter
Part Part
number | Image Mounting Housing number Mounting Housing
E26009 % Thru-hull P7 E26008 Thru-hull P371
E26019- Thru-hull B45 (|ncIud|ng E26005 Transom ST69
PZ fairing block) mount
M78717 Thru-hull B17
E26031 Thru-hull P120/ ST800
M78713- Thru-hull P319
PZ
M78716 Thru-hull B120
E26030 Thru-hull P17
E25025 Thru-hull P17
E26001- In-hull P79
PZ

tor)

E26027-
PZ

Transom P66
mount

A80373 In-hull P79S
T70278

— (in_

cludes

SeaTal-

kng adap-
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18.6 Instrument Wind Vane
transducer

The wind vane transducers listed below are
compatible with the following instrument displays:

+ 60 Wind

* {70 /i70s via iTC-5 converter

Part

number | Image Housing Mounting

E22078 Short arm Surface mount
wind vane

E22079 Long arm wind | Surface mount
vane

Options and accessories

18.7 Instrument Rotavecta
transducer

The wind transducers listed below are compatible

with the following instrument displays:

* i40 Wind
* i60 Wind
* i70/i70s via iTC-5 converter
Part
number | Image Housing Mounting
Z195 . Rotavecta Surface mount
| transducer

O
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18.8 Other transducers

When connected using an iTC-5, the transducers
listed below are compatible with the your i70 / i70s

18.9 SeaTalkne® cables and
accessories

SeaTalkng cables and accessories for use with
compatible products.

display:
Part number | Image Type
M81190 . Fluxgate compass
M81105 Rudder Reference

106

Description Part No | Notes
SeaTalkns starter kit | T70134 Includes:
* 1 x5 Way connector
(A06064)
+ 2 x Backbone terminator
(A06031)
« 1x3m (9.8ft) spur cable
(A06040)
* 1 x Power cable
(A06049)
SeaTalkng A25062 | Includes:
Backbone Kit + 2x5m (16.4ft) Backbone
cable (A06036)
« 1 x 20m (65.6ft)
Backbone cable
(A06037)
« 4 x T-piece (A06028)
+ 2 xBackbone terminator
(A06031)
« 1 x Power cable
(A06049)
SeaTalkng 0.4m A06038
(1.3ft) spur
SeaTalkd 1 m A06039
(3.3ft) spur
SeaTalks 3 m A06040
(9.8ft) spur
SeaTalkd 5 m A06041
(16.4ft) spur
SeaTalknd 0.4 m A06042
(1.3 ft) elbow spur
SeaTalkng 0.4m A06033
(1.3ft) backbone
SeaTalkd 1 m A06034
(3.3ft) backbone
SeaTalkd 3 m A06035
(9.8ft) backbone
SeaTalkng 5 m A06036
(16.4ft) backbone
SeaTalkny 9 m A06068
(29.5ft) backbone
SeaTalkng 20 m A06037
(65.6ft) backbone
SeaTalkd to bare | A06043

ends 1 m (3.3ft)
spur




Description Part No | Notes

SeaTalknd to bare | A06044

ends 3 m (9.8ft)

spur

SeaTalkng Power A06049

cable

SeaTalkng A06031

Terminator

SeaTalkng T-piece | A06028 | Provides 1 x spur
connection

SeaTalkns 5-way | A06064 | Provides 3 x spur

connector connections

SeaTalkng A06030

backbone extender

SeaTalk to E22158 | Allows the connection

SeaTalkng converter of SeaTalk devices to a

kit SeaTalkng system.

SeaTalknd Inline A80001 | Provides direct connection

terminator of a spur cable to the end
of a backbone cable. No
T-piece required.

SeaTalkng Blanking | A06032

plug

ACU / SPX R12112 | Connects an SPX course

SeaTalknd spur computer or an ACU to a

cable 0.3 m (1.0 ft) SeaTalknd backbone.

SeaTalk (3 pin) to | A06047

SeaTalkng adaptor

cable 0.4m (1.3ft)

SeaTalk to A22164

SeaTalkng spur 1

m (3.3ft) spur

SeaTalk2 (5 pin) to | A06048

SeaTalknd adaptor

cable 0.4m (1.3ft)

DeviceNet adaptor | A06045 | Allows the connection of

cable (Female) NMEA 2000 devices to a
SeaTalkng system.

DeviceNet adaptor | A06046 | Allows the connection of

cable (Male) NMEA 2000 devices to a
SeaTalkng system.

DeviceNet adaptor | E05026 | Allows the connection of

cable (Female) to NMEA 2000 devices to a

bare ends. SeaTalkng system.

DeviceNet adaptor | E05027 | Allows the connection of

cable (Male) to bare NMEA 2000 devices to a

ends. SeaTalkng system.

Options and accessories
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18.10 SeaTalkng cable kits

SeaTalkng starter kit (T70134)

Parts included

Quan-
tity

Connector A

Cable

Connector B

Length

Spur cable
(A06040)

1

3m (9.8f)

Power cable
(A06049)

1m (3.3f)

Backbone
terminator
(A06031)

N/A

5-way connector
(A06064). Each
connector block
allows the
connection of up
to 3 compatible
devices. When
correctly
terminated, a
connector block
forms a complete
backbone.
Multiple connector
blocks can be
daisy-chained
together.

N/A

SeaTalkng Backbone kit

(A25062)

Parts included

Quan-
tity

Connector A

Cable

Connector B

Length

Backbone cable
((A06036))

2

5m (16.4f)

Backbone cable
((A06037))

20m (65.61t)

Power cable
(A06049)

1m (3.3f)

108




Quan-

Parts included tity Connector A Cable Connector B Length
T-piece (A06028) | 4 ! N/A N/A N/A
Backbone 2 N/A N/A N/A
terminator
(A06031)

SeaTalkng Evolution cable kit (R70160)

Quan-

Parts included tity Connector A Cable Connector B Length
Backbone cable | 2 5m (16.4ft)
((A06036))
Power cable 1 1m (3.3ft)
(A06049)
Spur cable 1 1m (3.3ft)
(A06040)
ACU / SPX power | 1 0.3m (1.0ft)
cable (R12112)
(for powering
the SeaTalkng
backbone from the
autopilot system.
5-way connector | 1 N/A N/A N/A

(A06064). Each
connector block
allows the
connection of up
to 3 compatible
devices. When
correctly
terminated, a
connector block
forms a complete
backbone.
Multiple connector
blocks can be
daisy-chained
together.

Options and accessories
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Quan-

Parts included tity Connector A Cable Connector B Length
T-piece (A06028) | 2 k N/A N/A N/A
Backbone 2 N/A N/A N/A
terminator
(A06031)

SeaTalkng converter kit (E22158)

Quan-

Parts included tity Connector A Cable Connector B Length
Power cable 1 1m (3.3ft)
(A06049)
Backbone 2 N/A N/A N/A
terminator
(A06031)
Blanking N/A N/A N/A
plug(A06032)
SeaTalk (3 pin) 1 g 0.4m (1.3ft)
adapter cable
(A06047)
SeaTalk to 1 N/A N/A N/A
SeaTalkns con-
verter(E22158).

Enables the con-
nection of SeaTalk
devices to a
SeaTalkng system.
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18.11 SeaTalk accessories

SeaTalk cables and accessories for use with

compatible products.

Description

Part No

Notes

3-way SeaTalk
junction box

D244

1 m (3.28 ft)
SeaTalk extension
cable

D284

3 m (9.8ft) SeaTalk
extension cable

D285

5 m (16.4ft)
SeaTalk extension
cable

D286

9 m (29.5ft)
SeaTalk extension
cable

D287

12 m (39.4ft)
SeaTalk extension
cable

E25051

20 m (65.6ft)
SeaTalk extension
cable

D288

Options and accessories
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Appendix A Supported NMEA Transmit-
2000 PGN list PGN Description Received | ted
129039 AIS Class B Position o
Transmit- Report
PGN Description Received | ted 129040 AlS Class B o
59392 ISO ° ° Extended Position
Acknowledgment Report
59904 ISO Request ° 129041 AIS Aids to °
60928 | ISO Address Claim . . Navigation
NMEA - Request ° ° 129044 Datum ° °
126208 group function 129283 Cross Track Error ° °
126464 PGN List.— Receive i L 129284 Navigation Data o °
pransinit PN’ 129291 | Set & Drift, Rapid .
P - Update
126992 | System Time ° ° 129801 | AIS Addressed .
126996 Product Information ° o Safety Related
127237 | Heading/Track . Message
Control 129802 AIS Safety Related °
127245 | Rudder o ° Broadcast Message
: 129809 AIS Class B CS °
127250 Vessel Heading ° o Static Data Report
127251 Rate of Turn o L PtA
127257 Attitude ° 129810 AIS Class B CS o
127258 | Magnetic Variation . o g:aélc Data Report
i [ ]
127488 Egg}geuifjﬁ?eters’ 130306 | Wind Data . .
127489 Engine Parameters, . 130310 Environmental * *
Dynamic Parameters
127493 Transmission ° 130311 Environmental o °
Parameters Parameters
Dynamic 130576 Small Craft Status i
127496 Trip Parameters, ® 130577 Direction Data .
Vessel
127497 Trip Parameters, °
Engine
127498 Engine Parameters, °
Static
127505 Fluid Level o
127508 Battery Status °
128259 Speed ° °
128267 Water Depth (below ° °
transducer)
128275 Distance Log ° °
129025 Position, Rapid o °
Update
129026 COG & SOG, Rapid ° °
Update
129029 GNSS Position Data ° °
129033 Time & Date ° °
129038 AIS Class A Position °
Report

Supported NMEA 2000 PGN list
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